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1. Abstract

The course ,Spatial Information Systems” usually takes place in the fourth
semester of the B.sc. degree course “Forstwissenschaften und Walddkologie”
(Forestry and ecological Systems) at the University of Goéttingen. Within this
course, students earn basic information about geographic information systems
and desktop GIS applications, by name ArcCatalog and ArcMap. Those who
complete this course successfully should be able to work on small GIS projects.
To support the learning process of students, an e-learning course was
developed in 2008. It contains 41 units of small films about the basic steps in
ArcMap for every exercise and gives some advice to succeed on those.

At first, the aim of this work was to analyze these films in order to gather
information about the aims of the learning process of each exercise. After that,
a concept to assign the existing course on open source software should be
developed. The chosen software was gvSIG, made by the Spanish company
IVER on behalf of the regional government for infrastructure and transports of
the Spanish province of Valencia. By name, gvSIG 1.9 was used, which is
already an instable release candidate from the upcoming gvSIG 2. For

comparison, gvSIG 1.0 was used, which contains less functionality.

At the next step, proposals for solutions were developed in order to work on
the given exercises with gvSIG. Based on those proposals, the attempt to assign
the course on gvSIG was made. It should come to an end in a new row of small

teaching films.

First orientation in gvSIG was given by tutorials and workshops, also with
learning by doing. In order to get a closer appreciation about and to achieve
possibilities of gvSIG, all given exercises were inspected. Also functionality of

gvSIG in order to fulfill the requirements of the course was determined.

In conclusion, gvSIG was able to fulfill most of the requirements. Proposals for

solutions were developed for the predominant part of the given exercises.



2. Einleitung

Im Rahmen des Bachelorstudiengangs ,,Forstwissenschaften und Walddkologie”
der Universitat Gottingen wird im vierten Semester das Pflichtmodul
»Naturschutz und Raumbezogene Informationssysteme® an der Fakultat fur
Forstwissenschaften und Walddkologie angeboten (PO, 2007). Das Teilmodul
»Raumbezogene Informationssysteme” (RI) vermittelt, aufgeteilt in
Vorlesungen und Ubungen, die wesentlichen theoretischen Grundlagen
geographischer Informationssysteme (GIS). In den Ubungen steht die
praktische Umsetzung gangiger Arbeitsschritte zur Bearbeitung von GIS
Projekten, unter Verwendung der Programme ArcCatalog und ArcMap (ArcGis),
im Vordergrund (MADER, 2008). Die Ubungen umfassen 50 Aufgaben zu
unterschiedlichen Themen: von der einfachen Erstellung von Geodaten bis zur
kartographischen Ergebnisdarstellung. Zur Unterstiitzung der Studierenden
wurde in der Abteilung fiir Okoinformatik, Biometrie und Waldwachstum der
oben genannten Fakultdt ein multimedial aufgebauter E-Learning Kurs
entwickelt. Seine 41 Kursbestandteile werden in einer Instanz des ILIAS
Learning Management System (ILIAs, 2009) zur Verfligung gestellt.

Fir die ,Umsetzung des Kurses Rl auf Open Source Software” wurde das
Programm ,,gvSIG” ausgewahlt. Im ersten Teil dieser Arbeit erfolgte zunachst
eine Auseinandersetzung mit dem mir bis dahin unbekannten Programm. Im
Anschluss daran wurden die einzelnen Kursbestandteile des E-learning Kurses
im Hinblick auf theoretische Inhalte und das methodische Vorgehen zum
Erreichen der Lernziele untersucht. Auf Basis dieser Untersuchung wurde ein E-
Learning Kurs entwickelt, welcher das fiir ArcGis bestehende Konzept als
Vorlage fir die Umsetzung mit gvSIG (GVSIG, 2009) nutzt. Die erstellten
Kursbestandteile werden in Form von kurzen Videosequenzen zur Verfligung

gestellt.



2.1 gvSIG

Das regionale Amt fiur Infrastruktur und Transportwesen der spanischen
Provinz Valencia (Conselleria de Infraestructuras y Transporte de la Generalitat
Valenciana) untersuchte im Jahr 2002 die Mdoglichkeit, sein gesamtes
Computersystem auf Open Source Software umzustellen. Eine erfolgreiche
Umstellung des Systems versprach unter anderem niedrigere Kosten, eine
groBere Unabhangigkeit von firmeneigenen Dateiformaten und Technologien,
sowie eine hohere Sicherheit der Programme durch die Kontrolle des (offenen)
Quellcodes (ANGUIX UND DiAz, 2008). Im Jahr 2003 wurde die Entwicklung einer
Software zur Verarbeitung von Geodaten ausgeschrieben. Die Software sollte

sechs Vorgaben erfiillen:

I.  Ubertragbarkeit auf verschiedene Hardware- und Softwaresysteme,
insbesondere  Linux und Windows unter Verwendung der
Programmiersprache JAVA.

[I. Ein modularer Aufbau, bezogen auf die einfache Erweiterung der

Software zu spateren Zeitpunkten.

lll. Ein offener Code, der Quellcode der Software soll jeder Person zur

Verfligung stehen.

IV. Freie bzw. keine Lizenzen, liber den Abschluss der Entwicklung hinaus ist

die Software kostenlos und beliebig oft installierbar.

V. Vollstandig kompatibel, der Zugriff auf Daten, welche mit geschitzter
Software wie beispielsweise ArcView oder AutoCAD erstellt wurden, soll

ohne Anderung des Formats méglich sein.

VI. Orientierung an Standards, welche durch Richtlinien des Open
Geospatial Consortium (OGC) und der Europdischen Union definiert

werden.

(GVSIG (1), 2009).



Den Auftrag zur Entwicklung des Projekts bekam die spanische Firma IVER
Tecnologias de Information. Ein Konsortium der Universitat Jaume |, Castellon
de la Plana, Spanien, koordiniert und Uberwacht die Einhaltung der
internationalen Standards der OGC wahrend der Projektentwicklung (GVSIG (2),
2009). Der Name der Software ,gvSIG” ist ein Akronym von ,Generalitat
Valenciana Sistema de Informacion Geogrdfica” und wird als Werkzeug, das auf
die Bearbeitung und Organisation von geografischen Informationen
spezialisiert ist, bezeichnet. Der Anwender besitzt Zugriffsmoglichkeiten auf
gangige Raster- und Vektordatenformate, die von einer lokalen oder entfernten
Datenbank abgerufen und einzeln sowie kombiniert bearbeitet werden kénnen
(GvSIG (3), 2009). Ebenso verfligt er Uber Funktionen zum Bearbeiten,
Verwalten, Exportieren und Importieren von Daten verschiedener Arten
(RoDRIGUEZ, 2009). Nadheres Gber das Programm bzw. seine Funktionen werden
im Hauptteil dieser Arbeit vorgestellt.

In dieser Arbeit wird die Version gvSIG 1.9, welche als Release Candidate (RC)
verfligbar ist, vorgestellt. Da auf dem Entwicklungsstand dieses Release
Candidates lediglich mit geringfiigigen Anderungen in Bedienungsstruktur und
Funktionalitdt hinsichtlich der finalen Version zu rechnen ist (GvsIG
INTERNACIONAL MAILING LIST (1), 2009), halte ich es fir sinnvoll, die zukiinftige

Version zu verwenden.

2.2 Die Bedeutung von GIS in der Forstbranche

In einem Forstbetrieb werden taglich sach- und raumbezogene Daten erhoben.
Um diese Daten mit vertretbarem Aufwand in einen Zusammenhang zur
forstbetrieblichen Planung zu setzen, ist die Technologie der raumbezogenen
Informationssysteme bzw. GIS von Bedeutung (HEIDOBLER UND DAFFNER, 2009).
Ein GIS umfasst unterschiedliche Subsysteme, welche jeweils bestimmte
Aufgaben in der Manipulation und Verwaltung geographischer Daten
Ubernehmen und untereinander in Beziehung stehen. Um ein solches System
effizient zu nutzen, ist eine steuerbare Applikation, welche die Einzelsysteme
organisiert, kombiniert mit einer Benutzeroberflache und geeignetem Personal
unverzichtbar (KAppAs, 2001). Diese Funktion sollte eine moderne Desktop GIS
Software durch ihre Bereitstellung von Werkzeugen fir vielfaltige Aufgaben der
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Datenmanipulation und ihre Fahigkeiten zur Datenverwaltung erfillen. Mit der
Bearbeitung der Ubungsaufgaben des Kurses Rl soll die Funktionalitit der
freien und quelloffenen Software (Free and Open Source Software, FOSS) gvSIG

auf diese Anforderungen Uberprift werden.

3. Material und Methoden

3.1 Die Lehrveranstaltung ,Raumbezogene Informations-

systeme*

Die Informationen zu Lehrinhalten, Themengebieten und ihrer Unterteilung,

Aufbau der Lehrveranstaltung und zu den Ubungsaufgaben wurden der

III Ill

Foliensammlung ,RI“ sowie dem ,Ubungsskript zum Kurs RI“ von Dr. Felix
Mader, Stand Juli 2008, entnommen. Die Vorlesung als erster Teilbereich
vermittelt in funf Themengebieten die theoretischen Grundlagen fir die
Bearbeitung der Ubungsaufgaben innerhalb des zweiten Teilbereichs, den
angeleiteten Ubungen. Die Studierenden sollen nach Abschluss der
Lehrveranstaltung grundlegende Kenntnisse Uber GIS erlangt haben und

befdhigt sein, kleinere GIS Projekte eigenstandig zu bearbeiten.
3.1.1 Vorlesungsinhalte

In der Vorlesung werden zunachst GIS-Definitionen, GIS-Anwendungsbereiche
und GIS-Funktionen (I) vorgestellt. Die Studierenden werden in Karteninhalte
und Karteneigenschaften (ll) eingeflhrt, dabei werden Informationsebenen,
Symbolisierung, Malistabsbedeutung, Koordinatensysteme, insbesondere
Gaul-Kruger- und UTM-Systeme, und Kartenprojektionen erldutert. Unter
dem Punkt Geodaten und Geodatentypen (Ill) werden die Studierenden mit
Raster- und Vektordaten, sowie den verschiedenen Arten von Geoobjekten
vertraut gemacht. In diesem Zusammenhang erfolgt auch die Vorstellung des
Begriffs des Georelationalen Modells (IV). Den Abschluss bildet eine Ubersicht
zu den Moglichkeiten der Erfassung von Geometrie- oder Sachdaten (V). Die
Kenntnis der vermittelten Inhalte wird fiir die Bearbeitung der Kursbestandteile

vorausgesetzt.



3.1.2 Inhalte der Ubungsaufgaben

Die 50 Aufgaben aus dem Ubungsskript kénnen grob in sechs Bereiche
gegliedert werden. Zunachst wird sich mit dem Erstellen und Editieren von
Geodaten (l) befasst. Im Anschluss wird der Umgang mit Sachdaten und
relationalen Tabellen (II) gelbt, bevor es einen kurzen Exkurs in die
Datenkonvertierung (l11) gibt. Nach einer umfangreichen Ubungsaufgabenreihe
zur Selektion tber rdumliche Daten und Sachdaten (1V), sowie zu rdumlichen
Analyseoperationen (V), bildet die kartographische Ergebnisdarstellung (VI) den
Abschluss der Ubungsveranstaltungen. Fiir die Umsetzung dieser Aufgaben in
gvSIG sollen Aufgabenstellung und Aufbau der Ubungseinheiten, soweit
moglich, Ubernommen werden. Um die Aufgaben mit ArcGIS erfolgreich
bewiltigen zu kénnen, sollten sidmtliche Ubungen durch den Lernenden

bearbeitet worden sein.
3.1.3 Kursbestandteile des E-Learning Kurses RI

Als Vorlage fir die Umsetzung des Kurses Rl unter Verwendung von gvSIG
dienen die 41 Einheiten des 2008 entwickelten E-Learning Kurses. Die
Einheiten umfassen jeweils ein bis zwei Ubungsaufgaben. Ein einzelner
Kursbestandteil gliedert sich in eine Einleitung, in welcher das Ziel der
jeweiligen Aufgabe sowie die gezeigten Schritte kurz genannt werden, gefolgt
von einer Anleitung in Form eines kurzen Films. In diesen Filmen werden die
prinzipiellen Vorgehensweisen, welche zur Bearbeitung der Aufgaben
erforderlich sind, hinreichend dargestellt. Auf einen direkten Bezug zu den zu
bearbeitenden Aufgaben wird verzichtet. Die Teilnehmer des Kurses sollen so
angehalten werden, die Aufgaben selbststandig zu |6sen. An die Anleitung
schlieRt sich die Aufgabenstellung gemiR dem Ubungsskript an. Als
abschlieRender Teil jeder Lerneinheit wird der Sprechtext der einzelnen Filme
in schriftlicher Form zur Verfligung gestellt. Die einzelnen Kursbestandteile
wurden mit Blick auf den theoretischen Hintergrund, die gezeigten
Arbeitsschritte, die Formulierung der Sprechtexte sowie der verwendeten
Daten untersucht. Der zu entwickelnde Kurs wird sich an diesen Ergebnissen

orientieren.



3.2 Verwendete Computerprogramme
3.2.1 gvSIG

gVvSIG stellt in dieser Arbeit zum einen den Untersuchungsgegenstand dar und
zum anderen ist die Software das Werkzeug fiir die Umsetzung des Kurses RI.
Geeignet ist gvSIG hauptsachlich fir die Arbeit mit Ublichen
Vektordatenformaten. Umfassende Funktionen flr die Bearbeitung von
Rasterdaten konnen Uber die Erweiterung SEXTANTE integriert werden
(STEINIGER UND HAY, 2009). Der Abruf von Daten aus Geodatenbanken wie
postGIS oder mySQL wird unterstltzt. Es kdnnen Karten erstellt, Objekte
beschriftet oder Selektionen auf verschiedene Arten vorgenommen werden.
Tabellenoperationen wie Abfragen, statistische Auswertungen und
Tabellenverkniipfungen kénnen durchgefiihrt werden. Ein Editiermodus steht
fur Vektor- und Rasterdaten sowie fur Tabellen zur Verfiigung. Des Weiteren
bietet gvSIG umfangreiche CAD-Funktionen und einige Geoprocessing-
Werkzeuge. Ausgerichtet auf den Bezug von Geodaten liber Web-Dienste,
unterstitzt gvSIG die Dienste des OGC - wms, wfs und wcs - ebenso wie den
Bezug von Daten liber ArcIMS (ANGUIX UND DiAz, 2008). Die Einarbeitung in die
Software geschah unter Verwendung zweier Tutorials (CANALEJO, 2007
CANALEJO UND SCHONBUCHNER (1), 2008), eines Workshops (CANELEJO UND
SCHONBUCHNER (2), 2008) sowie des Ubungsskripts Rl und der Kursbestandteile
des E-Learning Kurses RI. AnschlieBend wurde jede Ubungsaufgabe mit gvSIG

1.9 RC bearbeitet und das Ergebnis dokumentiert.
3.2.2 SEXTANTE-Erweiterung fir gvSIG

Die Erweiterung SEXTANTE (Sextante, 2009), welche urspriinglich als GIS
speziell fir den Einsatz im Forstbereich entwickelt wurde (Sextante, 2008) stellt
eine eigenstandige JAVA-Bibliothek dar (Olaya (1), 2008). Sie kann prinzipiell
von auf JAVA basierenden Desktop GIS-Anwendungen genutzt werden (Olaya
(2), 2008). Entwickelt wird SEXTANTE an der Universitat von Placencia, Spanien,
in Kooperation mit der lokalen Regierung der Region Extremadura. Sie umfasst
in der Version SEXTANTE 0.30 insgesamt 241 Geoprocessing-Algorithmen fir

die Bearbeitung von Raster- und Vektordaten, wobei der Fokus auf der Analyse



von Rasterdaten liegt. Ein GrofSteil der Programmarchitektur entstammt dem
Projekt SAGA (SAGA, 2009) der Universitat Gottingen. Von dem Projekt wurden
etwa 120 fertige Algorithmen tGbernommen. Gedacht als Erweiterung fir die
SAGA Plattform, wurden etwa 70 zusatzliche Algorithmen entwickelt. Mit
wachsender Reife des gvSIG Projekts entschloss sich das Entwicklerteam zu
einer Zusammenarbeit, um das vektordatenorientierte gvSIG um Funktionen
fur die Rasterdatenverarbeitung zu erweitern (Olaya(1), 2008). Verwendet wird
nicht die Version 0.30, sondern eine spezielle fir gvSIG 1.9 RC entwickelte

Version (gvSIG internacional mailing list (2), 2009).

3.2.3 Camtasia

Mit der Software Camtasia der Firma TechSmith aus Okemos, Michigan (USA),
wurden die Lehrfilme produziert. Es handelt sich um eine Desktop-Aufnahme-
Software, welche auf dem Monitor sichtbare Vorgange wahrend der Arbeit
mitschneidet und in Form von Videodaten speichert. In der Version 6 bietet die
Software umfangreiche Funktionen flr die nachtragliche Bearbeitung der
aufgenommenen Filme. Bendtigt wurden hauptsachlich die Funktion fur die
Verlangerung von einzelnen Bildern (Frameerweiterung), Zoom und die Callout

Funktion.
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4. Ergebnisse

Kleinere Probleme stellten sich praktisch sofort ein, denn der erste
Installationsversuch mit gvSIG 1.0, die Version gvSIG 1.9 RC war mir Mitte
August 2009 noch unbekannt, gelang nicht. Nachdem ich eine Installerdatei mit
integriertem JAVA Update bekam, liel sich gvSIG problemlos installieren. Gleich
darauf installierte ich SEXTANTE 0.30, jedoch aufgrund mir nicht verstandlicher
Konflikte in Verbindung mit JAVA nicht erfolgreich. Unternommen wurden
Installationsversuche auf sieben Rechnern, wobei es lediglich bei einem
Rechner, unter Windows Vista, zu dhnlichen Problemen kam. Alle anderen
Systeme verwendeten Windows XP oder Windows 2000. Die Installation von
gvSIG 1.9 RC verlief einwandfrei, ebenso wie die der hierzu entwickelten

SEXTANTE.

4.1 Programmoberfliche

Nach jedem Start des Programms ist zunachst der ,Project Manager” (PM)
geoffnet. Er stellt die Steuerungszentrale fir Verwaltungs- und Organisations-
aufgaben dar. Es lassen sich neue Views, so werden Data Frames in gvSIG
genannt, anlegen und verwalten. Tabellen kénnen hier gedffnet und dem
Projekt  hinzugefigt werden, als dritte Option ldsst sich ein
Kartenerstellungsfenster 6ffnen. Jedes dieser drei Elemente wird in einem
gesonderten Fenster gedffnet und die entsprechend verwendbaren Symbole
fur die Werkzeuge (Tools) automatisch eingeblendet. Generell sind die Symbole
fur die verschiedenen Tools in gvSIG 1.9 eindeutig veranschaulicht worden.

Das Fenster eines gedffneten Views ist in drei Bereiche gegliedert. Den GroRteil
nimmt der Arbeitsbereich ein. Links oben befinden sich der Table of Content
(TOC) und darunter ein Bereich fiir eine Ubersichtsansicht. In der FuRleiste
werden rechts unten der aktuelle Malstab, die Karteneinheit und, nach
vorheriger Angabe der Projektion, die Koordinaten angezeigt. Das
Projektionssystem wird nicht vom ersten geladenen Datensatz Gibernommen.

Es kann zwar ,,on the fly“ projiziert werden, aber grundsatzlich muss es manuell
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eingestellt werden. Zu diesem Zweck ist es moglich, ein Standard-
projektionssystem festzulegen, welches jedem View automatisch zugrunde
liegt und bei Bedarf gedndert werden kann. Wird ein Layer mit einem anderen
Projektionssystem einem View hinzugefligt, ldsst sich die gewilnschte
Projektion bei der Layerauswahl definieren.

Dateipfade werden in gvSIG ausschlieBlich absolut gespeichert (GVSIG
INTERNACIONAL MAILING LIST, 2008). Ladt man ein Projekt in gvSIG 1.9 RC auf
einem anderen Rechner oder nachdem die Projektdaten verschoben wurden,

wird jedoch nach einem neuen Pfad fur die fehlenden Daten gefragt.

4.1.1 Layer und Attributtabellen

Mochte man zu einem View einen Layer hinzufligen, so muss fir verschiedene
Datenarten der jeweilige Treiber aus einer Drop Down Liste selektiert werden.
Es werden ausschlief3lich die Dateien angezeigt, welche vom gewahlten Treiber
unterstitzt werden. Eine Bearbeitung des Layers ist ausschliefllich in
aktiviertem Zustand maoglich. Selektionen beispielsweise kénnen somit nur fir
den jeweils aktiven Layer durchgeflihrt werden. Um diverse Elemente aus
mehreren Layern zugleich auszuwahlen, gibt es die Mdglichkeit, mehrere Layer
zu aktivieren bzw. die entsprechenden Layer im TOC zu einer Gruppe
zusammenzufassen. Selektionen aus Layern oder Tabellen kdnnen in
unterschiedliche Datenformate exportiert werden.

Attributtabellen eines Layers lassen sich Gber ein Symbol bzw. im Meni , Layer”
der Kopfleiste aufrufen. Tabellen ohne Geometriebezug missen lber den PM
hinzugefliigt werden. Zum Bearbeiten von Tabellen oder Layern muss der
Editionsmodus gestartet werden. Dieser wird fiir einen Layer und die
zugehorige Attributtabelle oder fur eine eigenstandige Tabelle unterschiedlich
aktiviert; jeweils im Menl des ,Layer” bzw. ,Table” in der Kopfleiste. Der
Editionsmodus besitzt, vor allem fiir die Vektordatenbearbeitung, sehr
umfangreiche Werkzeuge. Fir Tabellen ist er etwas sparlicher ausgestattet,
jedoch voll funktionsfahig und umfasst unter anderem einen ,Field Manager”
flir die Gestaltung des Tabellenlayouts und einen ,,Field Calculator”. Es kdnnen

neue Shapefiles erstellt werden, Konvertierungsfunktionen fiir ESRI-Daten-
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formate wie Coverage oder personal Geodatabase stehen jedoch nicht zur
Verflgung.

Die Exportfunktion fur eigenstandige Tabellen ist nach meiner Erfahrung nur
zum Teil zuverlassig. Eine Gber eine ODBC-Verbindung importierte Excel-Tabelle
sollte in eine dBase-Tabelle, zwecks weiterer Bearbeitung, exportiert werden.
Da dies nicht regelmadlig gelang, stellte ich diesbezlglich eine Frage an die
gvSIG-Mailinglist, welche jedoch bisher unbeantwortet blieb (GvSIG
INTERNACIONAL MAILING LIST (3), 2009). Join- und Linkverknlpfungen fur Tabellen
sind moglich. Im Gegensatz zur Relateverkniipfung in ArcGIS ist die Linkfunktion
in gvSIG nur in eine Richtung moglich (IVER (1), 2007 UND GVSIG INTERNACIONAL
MAILING LIST (4), 2009). Funktionen fir sachdatenbezogene Abfragen oder
raumlich bedingte Auswahl von Objekten sind vorhanden, ebenso wie fir
gruppierte Berechnungen statistischer Kennzahlen aus Tabellen. Dabei ist zu
beachten, dass gvSIG nur Schllsselfelder des gleichen Typs akzeptiert. Es kann
somit notwendig sein, die Tabellen vor einer Abfrage entsprechend

vorzubereiten.

4.1.2 Geoprocessing

Uber die ,,Geoprocess Toolbox“ steht dem Anwender eine kleine Auswahl an
Tools flir Geoprocessingaufgaben zur Verfligung. Sie umfasst unter anderem
Buffer, Clip, Intersect und Union. Diese Tools sind einfach zu nutzen und
samtlich funktionsfahig. Die von SEXTANTE fur gvSIG1.9 RC zur Verfligung
gestellten Algorithmen gaben zum Teil fehlerhafte Ergebnisse aus. Der Befehl
»Polygon to Polyline” lieferte beispielsweise nicht das gewlinschte Ergebnis, es
wurde eine Liniengeometrie in einem zuvor leeren Bereich berechnet.
AuBBerdem waren die ausgegebenen Dateien fehlerhaft. lhnen fehlte die
Dateiendung, welche allerdings im Dateinamen enthalten war. Nach
Umbenennung der Dateien waren sie technisch verwendbar.

Die von der Erweiterung SEXTANTE, in der Version 0.30, genutzten Algorithmen

lieferten korrekte Ergebnisse.
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4.1.3 Kartenerstellung

Der Modus zur Kartenerstellung in gvSIG ist, nach kurzer Einarbeitungszeit, sehr
praktisch zu bedienen. Im ,Map“ Meniu in der Kopfleiste, bzw. Uber
entsprechende Symbole, lassen sich iber den Unterpunkt ,Insert” Elemente
wie Ansichten (Views), MaRstab, Legende, Nordpfeil, oder auch Geometrien,
Text und Bilder zum Kartenlayout hinzufiigen. Eine Ubersichtskarte mit
Ausdehnungsrechteck kann ebenfalls eingefligt werden. Diese muss jedoch
vorher fur den entsprechenden View definiert werden. Auf einer leeren
Kartenvorlage muss zundchst ein Bereich per Aufzieh-Rechteck ausgewahlt
werden, bevor man die Ansicht eines beliebigen, gerade gedffneten Views oder
ein anderes Kartenelement einfiigen kann. Die fertige Karte kann gedruckt,

oder beispielsweise in ein Pdf exportiert werden.
4.2 Probleme bei der Bearbeitung der Ubungsaufgaben

Das ,Kopieren von Ubungsdaten” (3)! und die , Datenvorschau” (4) konnten,
aufgrund nicht vorhandener Funktionen, nicht bearbeitet werden. Die Aufgabe
»Layer — Eigenschaften — Beschriftung” (13) konnte mit gvSIG 1.9 RC nicht wie
gewilinscht angewendet werden. Nach der Eingabe einer festen TextgroRe
wurden keine Beschriftungen angezeigt.

Die ,Online Hilfe“ (15) ist vorgesehen, in dieser Version noch nicht

funktionsfahig.

Die Ausrichtung von gvSIG auf den Bezug von Daten aus dem Netz wirkt sich
auf die Aufgabe ,Layer —Eigenschaften — Koordinatensysteme” (18) aus. gvSIG
verflgt Gber keine mir bekannte Funktion, um das zugrunde liegende raumliche
Referenzsystem eines Layers zu identifizieren. Wie in Punkt 4.1.2 kurz erwahnt,
wurde der Geoprocessing-Befehl zum ,Konvertieren von Flachen zu
Liniengeometrien” (33), ,,Polygon to Polyline” nicht wie erwartet ausgefiihrt.
Die von gvSIG erstellte Attributtabelle des neuen Linienshapefiles enthielt 40
Eintrdge. Die von ArcMap ausgegebene Tabelle zu dieser Aufgabe enthielt

jedoch 101 Eintrage.

1 .
Nahere Informationen zu den hier bezeichneten Aufgabenstellungen (Nr.) entnehme man dem Ubungsskript Rl
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Die ,manuelle Editierung von Geodaten und Sachdaten (34)“ konnte nicht
erfolgreich durchgefiihrt werden. Das Programm ist im Editionsmodus fir
Vektordaten sehr instabil und stirzt willklrlich ab. Das ,Konvertieren von
Geodaten” (35) und das ,Erstellen einer neuen Feature Class” (36) wurden
nicht im Sinne der Aufgaben bearbeitet. Es konnte mit gvSIG nicht auf die

Inhalte der personal Geodatabase und des Coverages zugegriffen werden.
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Einzelne Bestandteile der Aufgaben wie das Erstellen eines Shapefiles und einer

Liniengeometrie, konnten jedoch erfolgreich bearbeitet werden.

4.3 Erstellen der Kurseinheiten

Es konnten mit gvSIG von den 50 existierenden Aufgaben 42 erfolgreich
umgesetzt werden. Die Resultate werden durch die 20 Lehrfilme im Anhang
dargestellt. In den Filmen konnten die in gvSIG notwendigen Arbeitsschritte zur
Losung der Aufgaben hinreichend gezeigt werden. Erganzend wurden 2 Filme
zu gvSIG-spezifischen Einstellungen und Funktionen produziert. Aus
thematisch-praktischen Grinden und aufgrund der Ausrichtung auf eine
Zielgruppe, welche bereits liber Kenntnisse im GIS-Bereich verfigt, wurden zum
Teil mehrere Aufgaben in einer Kurseinheit zusammengefasst. Die Sprechtexte
wurden durch zusatzliche Erklarungen an komplexen Stellen und gvSIG-
spezifische Hinweise ergdnzt. Innerhalb der Filme werden Hinweise wie die
Hervorhebung einzelner Elemente oder Erganzungen in Form kurzer Texte bzw.
in Form sog. ,Callouts” gegeben. Leider konnten bis zum Abgabetermin

lediglich 20 von geplanten 26 Filmen umgesetzt werden.
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5. Diskussion

Die Umsetzung des Kurses Rl auf Open Source Software unter Verwendung von
gvSIG gestaltete sich als umfangreicher Prozess. Daher soll die Diskussion der

Ergebnisse in einzelnen Schritten erfolgen.
5.1 Auseinandersetzung mit gvSIG

Wie erlautert, befasste ich mich zunachst mit der aktuell stabilen Version gvSIG
1.0. Nach ersten ,learning by doing”“ Versuchen mit Hilfe der gvSIG
Bedienungsanleitung bekam ich den Eindruck eines oberflachlich verstand-
lichen, in der Bedienung jedoch recht unausgereiften Desktop-GIS. Die
programmspezifische Arbeitsweise erschien mir im Vergleich zu dem mir
bekannten ArcGIS zundchst als umstandlich. Die Erkenntnisse aus der Arbeit
mit den Tutorials halfen diesbeziglich nur bedingt, da sie zwar leicht und gut
verstandlich sind, mir als GIS-Laien jedoch durch den unzusammenhdngenden
Aufbau zum Teil Ratsel aufgaben. Zum besseren Verstandnis bearbeitete ich
nach den Tutorials einzelne, einfache Ubungsaufgaben parallel mit gvSIG und
ArcGIS. Dadurch wurden die Ablaufe deutlich klarer, zumal ich die Ergebnisse
nun vergleichend Uberprifen konnte, was bei der Arbeit mit den Tutorials nur
bedingt moglich war. Hier zeigte sich bereits erstmals, dass gvSIG zuverldssige
Ergebnisse ausgab, auch wenn es sich dabei um Dinge wie Symbolisierung oder
einfache Abfragen innerhalb von Attributtabellen handelte, wobei ich keine
Probleme erwartete. Wahrend der ersten etwas weitergehenden Versuche
offenbarten sich kleinere Schwachen. Stellvertretend fiir einige kleine, nicht
sofort verstandliche Ablaufe soll das folgende Beispiel stehen. Nicht nur in
gvSIG konnen ausschlielllich Layer bearbeitet werden, welche aktiviert sind.
Nun muss das Deaktivieren von Layern hier sehr bewusst getan werden, woran
man sich jedoch schnell gewdhnt. Dies ist nicht prinzipiell negativ zu bewerten,
geht es doch darum, ungewollte Arbeitsschritte in anderen Layern zu
vermeiden. Das Programm fragt, beispielsweise wahrend der Durchfiihrung
eines Geoprocessingbefehls, nach dem Inputlayer und liefert gleichzeitig einen
Layer als Vorschlag. Allerdings ist hier nicht zwingend der aktuell aktivierte
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Layer ausgewahlt. Vorgeschlagen wird immer der Layer, welcher sich an
unterster Stelle im TOC befindet. Dieser Umstand gilt auch fur die Arbeit mit
Tabellen oder bei der Kartenerstellung. Die daraus resultierenden, strukturell
gleichen Arbeitsabldaufe sind wiederum positiv fir den Anwender zu bewerten.
Ist er einmal mit der Bedienungsstruktur vertraut, ist es recht einfach, weitere,
noch unbekannte Funktionen zu nutzen. Unterstltzend wirken hier die klar
strukturierte Programmoberflaiche und die schlicht gehaltene Meniileiste in
Verbindung mit eindeutigen Symbolen fiir die Tools. Bei der spateren
Auseinandersetzung mit gvSIG 1.9 gab es diesbeziglich keine Veranderungen.
Lediglich das Aussehen wurde zum Positiven hin verdndert. Solange der
Anwender Uber grundsatzliche GIS-Kenntnisse verfugt, sollte die Software,

unabhangig von der Version, recht schnell beherrschbar sein.
5.2 Weitere Arbeitsschritte

Durch die Ansicht aller Kurseinheiten des E-Learning Kurses Rl und
gleichzeitiger Untersuchung hinsichtlich gezeigter Arbeitsschritte und
Methoden sollten unter anderem Erkenntnisse Uber die einzelnen Lernziele
gewonnen werden. Gemessen am recht hohen Aufwand dieses Prozesses
hatten die Ergebnisse hierzu auch allein durch die Durchfiihrung der
Ubungsaufgaben erlangt werden kénnen. Allerdings waren die gezeigten
Schritte in den Kurseinheiten fir mich von besonderem Interesse. Dadurch
konnten erste Ansatze fiir die Konzeption der neuen Kurseinheiten entwickelt
werden, sowie eine Einschatzung des Arbeitsaufwands zur Erstellung der Filme,
wenngleich ich diesen dennoch unterschitzte. Grinde hierfiir sehe ich
hauptsachlich in meiner Unerfahrenheit mit gvSIG. Die Software Camtasia lie
sich einfach bedienen und erleichterte die Filmproduktion sehr, auch aufgrund
des Angebots von Videotutorials zu den einzelnen Funktionen durch den
Hersteller und der umfangreichen Dokumentation. Was dies betrifft, besteht
fur gvSIG noch Nachholbedarf. Die Dokumentation mag fir Anwender aus dem
spanischsprachigen Raum umfassend sein, fiir anderssprachige Anwender
wirde ich sie als ausreichend beschreiben. Ausdriicklich ausgenommen sei
hiervon die englische Bedienungsanleitung, welche sehr ausfiihrlich gestaltet

wurde. Ob man diesbeziglich hohe Erwartungen an FOSS stellen kann, méchte
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ich nicht verneinen. Ein hoherer Aufwand in Bezug auf englischsprachige
Dokumentation kann FOSS und damit auch gvSIG nur zugute kommen. Gerade
eine FOSS, zu deren Prinzipien die Entwicklung durch den Anwender gehort,

profitiert davon.
5.3 Probleme und Fehlfunktionen

Es kam bei der Durchfiihrung der Ubungsaufgaben nicht nur zu den unter 4.2
erwdhnten Problemen. Angefangen bei Installationsproblemen, welche sich in
Verbindung mit gvSIG 1.9 RC jedoch nicht wiederholten, iber teilweise unklare
Bedienungsvorgdnge bis hin zu fehlerhaften Algorithmen und damit falschen
Ergebnissen. Ein  GroRteil der aufgetretenen Fehlfunktionen sind dem
Softwarestatus ,Release Candidate” zuzuschreiben. Dies konnte durch
Uberpriifung mittels Funktionen des stabilen gvSIG 1.0 festgestellt werden.

Beschriftungen beispielsweise lieen sich hier problemlos umsetzen, in gvSIG
1.9 RC jedoch nicht. Stellt man hier eine feste TextgréfRe ein, so werden die
entsprechenden Feldinhalte nicht abgebildet. Allerdings kann man hier davon
ausgehen, dass die Beschriftungsfunktion in der kommenden stabilen Version
funktionieren wird, was auch fir die Online-Hilfe gilt. Die Algorithmen der
SEXTANTE werden wohl nach abgeschlossener Integration in gvSIG 1.9 ebenso
zuverldssige Ergebnisse ausgeben wie in gvSIG 1.0. Im Zuge der Filmproduktion
konnte ein Loésungsweg gefunden werden, welcher diese Vermutung fiir den
Algorithmus ,,Polygon to Polyline” bereits nahelegt. Dies mdchte ich genauso
fur den sehr instabilen CAD-Modus behaupten. Schwieriger wird es bei den
Fehlern in Funktionen, welche in gvSIG 1.0 gar nicht vorhanden sind, wie bei
dem unter 4.1.1 beschriebenen Export der (ber ODBC importierten
Exceltabelle. Das Problem scheint etwas mit dem Speicherpfad und dem
angegebenen Namen zu tun zu haben. Manche Kombinationen aus
Speicherpfad und Dateiname waren erfolgreich, meist jedoch gab es eine

Fehlermeldung ohne Ausgabe einer Tabelle.

Der Nachteil, dass gvSIG fir die Verknupfung von Tabellen nur Felder des
gleichen Typs akzeptiert, hat i.d.R. keine falschen Ergebnisse zur Folge. Es

bedeutet jedoch bei entsprechenden Daten einen nicht unerheblichen
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Arbeitsaufwand, um die Tabelle vorzubereiten. Als unpraktisch empfand ich
die, im Vergleich zu ArcGIS, unflexible Gestaltung der Linkverkniipfung zweier
Tabellen. Um eine Abfrage in die andere Richtung auszufiihren, muss zundchst
der bestehende Link getrennt und andersherum wieder erstellt werden.

Ein Thema, welches mir trotz bemiihter Recherche nicht klar wurde, ist der
Umgang mit Projektionen und Koordinatensystemen in gvSIG. Es wird
anscheinend davon ausgegangen, dass sich der Anwender Information Uber
dem Geodatensatz zugrunde liegende Koordinatensysteme beschaffen kann,
oder die Geodaten in einem selbst auswahlbaren raumlichen Referenzsystem,
wie beispielsweise bei der Nutzung der wms-Dienste, bezieht. Es konnte nicht
herausgefunden werden, wie man in gvSIG das jeweils zugrunde liegende

raumliche Referenzsystem einzelner Layer identifizieren kann.

Abschliefend ist zu sagen, dass sich der Anwender, bei Vorhandensein
grundlegender GIS-Kenntnisse, schnell in gvSIG einarbeiten kann. Strukturell
klar gegliedert, werden wenig Fehler provoziert. Manche Funktionen sind im
Vergleich zu ArcGIS etwas umstdndlich zu benutzen, erfiillen jedoch ihren
Zweck zufriedenstellend. Der Umfang an Funktionen geht weit tber die zur
Bearbeitung der Ubungsaufgaben benétigten hinaus. gvSIG 1.9 wird seinem
aktuellen Status als Release Candidate gerecht. Obwohl weite Teile des
Programms verwendbar und stabil sind, gibt es doch noch einiges an Fehlern zu

beheben.

Der iiberwiegende Teil der Ubungsaufgaben konnte mit gvSIG gelést werden.
Somit waren die Voraussetzungen fiir die Entwicklung neuer Lehrfilme unter
Verwendung von gvSIG erreicht. Die in den Filmen dargestellten
Losungsvorschlage sind jedoch sicherlich weiter zu optimieren, insbesondere

wenn die zukinftige Version gvSIG 2 erschienen ist.
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6. Zusammenfassung

Das Teilmodul ,Raumbezogene Informationssysteme” wird Ublicherweise im
vierten Semester des Studiengangs ,Forstwissenschaften und Waldékologie”
an der Universitdat Gottingen angeboten. Unter anderem werden die
Studierenden in dieser Veranstaltung mit der praktischen Umsetzung gangiger
Arbeitsschritte zur Bearbeitung von GIS-Projekten, unter Verwendung der
Programme ArcCatalog und ArcMap, vertraut gemacht. Zur Unterstiitzung der
Studierenden wurde 2008 ein E-Learning Kurs entwickelt, in welchem die zur
Bearbeitung der Ubungsaufgaben notwendigen Schritte in ArcMap mittels
kurzer Lehrfilme dargestellt werden.

Ziel dieser Arbeit war es zunachst, die vorhandenen Lehrfilme im Hinblick auf
Lernziele und die Darstellung der Losungsvorschlage zu untersuchen und ein
Konzept fiir die Ubertragung auf Open Source Software zu entwickeln. Die
hierfir verwendete Desktop GIS Software, gvSIG, wurde von der spanischen
Firma IVER, im Auftrag des regionalen Amts fir Infrastruktur und
Transportwesen der spanischen Provinz Valencia, entwickelt. Konkret handelt
es sich bei der Software gvSIG 1.9 um einen als instabil bezeichneten Release
Candidate. Vergleichend wurde teilweise das stabile gvSIG 1.0 verwendet,

welches Uber einen geringeren Funktionsumfang verfiigt.

Anschlieend sollten Loésungsvorschlage entwickelt werden, um die
Ubungsaufgaben des Kurses ,Raumbezogene Informationssysteme” unter
Verwendung von gvSIG zu bearbeiten. Diese Losungsvorschlage sollen ebenfalls

in Form kurzer Lehrfilme den Studierenden zur Verfiigung gestellt werden.

Die Einarbeitung in die Software gvSIG erfolgte unter Zuhilfenahme von
Tutorials und Workshops, sowie durch ,learning by doing”. Fir ein tieferes
Verstandnis und um eine erste Einschatzung der Moglichkeiten der Software zu
erlangen, wurden die Aufgaben des Ubungsskripts ,Raumbezogene
Informationssysteme” bearbeitet, wobei auch die Funktionalitat der Software

in Bezug auf die Anforderungen der Ubungsaufgaben untersucht wurde. Es
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zeigte sich, dass gvSIG die meisten Anforderungen erfiillen konnte. Es wurden
Lésungsvorschlage unter Verwendung von gvSIG fiir den Gberwiegenden Teil

der Ubungsaufgaben in Lehrfilmen umgesetzt.
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Hiermit versichere ich, dass ich die vorliegende Arbeit selbststandig verfasst
und keine anderen als die angegebenen Quellen und Hilfsmittel verwendet

habe.

Gottingen, am 29. September 2009

(Samuel Schleich)
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Anhang 1: DVD mit Lehrfilmen sowie der gesamten

Bachelorarbeit als MS Word 2007 Datei

Anhang 2: Sprechtexte zu 20 Filmeinheiten
Film 1: Start und Spracheinstellung

Nach erfolgreicher Installation starten wir gvSIG. Ich verwende hier eine
Vorgdngerversion von gvSIG 2, den Release Candidate 1.9, daher bekomme ich
zundchst eine Warnmeldung angezeigt. Beim ersten Start ist die verwendete
Sprache Spanisch. Daher stellen wir die Sprache zunachst auf ein fir die
meisten von uns besser verstandliches Englisch um. Hierfir klicken wir auf das
Symbol fir die generellen Einstellungen, oder ,Preferences”. Wir wahlen
,General”, ,ldioma“, selektieren Englisch aus der Liste der angezeigten
Sprachen und bestitigen. Die Anderung wird erst nach einem Neustart des
Programms wirksam. Wir sehen die Programmoberflaiche nun in englischer

Sprache.

Film 2: Generelle Einstellungen

Um uns das Arbeiten mit gvSIG zu erleichtern, sollten jetzt einige generelle
Einstellungen vorgenommen werden. Dazu o6ffnen wir wieder die
,Preferences”. Als erstes legen wir einen Zeichensatz fir DBF-Tabellen fest. Ich
wahle ,ISO 8859-7“. Nun geben wir unter ,General”, ,Folders”, die
Standardverzeichnisse fir unsere Projekte und unsere Daten an. Wir kénnen
dabei beliebige Ordner oder Laufwerke angeben. Als nachstes stellen wir, unter
»Symbology”, die Standard-Fillfarbe ein. Ich wahle hier zufdllige Farben
(,Aleatory”). Unter dem Punkt ,View” kénnen wir Einstellungen festlegen,
welche jedem neu erstellten View zugrunde liegen. Worum es sich bei einem
View handelt, wird in der nachsten Lektion gezeigt. Eine wichtige Einstellung
betrifft die Projektion eines Views. Standardmafig soll das GauB-Krliger-System
— Zone 3 verwendet werden. Hierfiir benutzen wir die Suche Uber den EPSG

Code. Unter , Type” wahlen wir ,,EPSG” aus und suchen nach dem Code 31467.
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Die gesuchte Projektion wird in der Liste angezeigt. Zuletzt wahlen wir noch die
Standardfarbe fiir Selektionen aus. Ich persénlich bevorzuge Rot. Uber den
Schieberegler unterhalb der Farbe koénnen wir die Deckkraft der Farbe
einstellen. Diese Option ist bei den meisten Farbauswahleinstellungen in gvSIG
vorhanden. Nach einem Neustart des Programms sind die Einstellungen

ibernommen worden.

Film 3: Uberblick

Das erste, was wir nach jedem Programmestart von gvSIG zu sehen bekommen,
ist der ,,Project Manager”. Uber diese Funktion kénnen wir beliebig neue Views
erstellen, 6ffnen, umbenennen, I6schen oder ihre Eigenschaften ansehen. Ein
View stellt die Ubergeordnete Einheit dar, in welcher die verschiedenen
,Themes” oder auch Layer abgelegt werden kénnen. In ArcGIS ist dies der Data
Frame. Dem soeben erstellten View gebe ich den Namen Viewl. AuBerdem
konnen wir Tabellen auf unserer Festplatte oder aus einer Datenbank 6ffnen
und zu unserem Projekt hinzufligen. Als dritte Option kdnnen wir aus den
Daten, welche in unserem Projekt vorhanden sind, eine Karte erstellen. Es
stehen uns jeweils die genannten Optionen zur Verfigung. Unter dem
Menlpunkt ,,File“ haben wir die Moglichkeiten, ein neues Projekt zu erstellen,
ein bestehendes Projekt zu 6ffnen und unser Projekt zu speichern, bzw. unter

einem anderen Namen zu speichern.

Film 4: Layer hinzufiigen, Werkzeugleisten

Wir lernen nun gvSIG etwas genauer kennen. Unter anderem werden wir
sehen, wie man einem View einen Layer hinzufigt und was dies fir
Auswirkungen auf die Oberflache des Programms hat. gvSIG verfligt Gber eine
Vielzahl von Tools fiir die Bearbeitung unserer Projektdaten. Standig angezeigt
werden jedoch nur die Symbole fiir das Neuerstellen, Laden und Speichern
unserer Projekte, sowie fiir die Informationskonsole und die Preferences. Ist die
SEXTANTE-Erweiterung installiert, ist ihre Werkzeugleiste ebenfalls immer zu
sehen. Bewegt man den Mauszeiger auf eines der Symbole, wird seine
Bedeutung angezeigt. Wir wollen nun zundchst ein Shapefile dem View 1

hinzufliigen. Dazu oOffnen wir ihn, entweder Uber den Knopf oder per
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Doppelklick, und sehen, dass neue Symbole angezeigt werden. Wir klicken auf
,»Add Layer”, ,Add” und missen im folgenden Fenster zunachst den richtigen
Treiber auswahlen. Wir selektieren den Shapefile-Treiber. Nun kénnen wir die
gewlinschten Shapefiles auswahlen. Auch in gvSIG wirkt sich die Anordnung der
Layer im TOC auf die Darstellung aus. Wir 6ffnen das Kontextmenl mit der
rechten Maustaste und zoomen zu der vollen Ausdehnung des Layers. Ob ein
Layer aktiviert ist, erkennt man an seiner rechteckigen Hervorhebung.
Angezeigt wird ein Layer, wenn das Hakchen vor seiner Bezeichnung zu sehen
ist. Wir 6ffnen nun die Attributtabellen der Shapefiles liber das Symbol. Wir
aktivieren abwechselnd die verschiedenen Fenster und koénnen uns die
Symbole der jeweils angezeigten Werkzeugleisten ansehen. gvSIG stellt uns
immer die Werkzeuge zur Verfiigung, welche im gerade aktiven Fenster

verwendet werden kdnnen.

Film 5: Symbolisierung

Wir sehen hier eine recht einheitliche Symbolisierung. Die Darstellung der
Features eines Layers ldsst sich schnell tGber einen einfachen Doppelklick auf
das im TOC angezeigte Farbsymbol andern. Wir andern zunachst die Farbe der
Umgebung. Mochte man umfangreichere Symbolisierungseinstellungen
vornehmen, 6ffnet man im Kontextmeni des jeweiligen Layers die Properties.
Unter dem Punkt ,,Symbols“ lassen sich die Objekte eines Layers, beispielsweise
nach Kategorien oder Mengen, farblich darstellen. Unter dem Punkt , Labelling”
kénnen wir Beschriftungen auswahlen und ihre Darstellung unseren Wiinschen
anpassen. Fir diesen Layer vergeben wir nun Farben nach einmaligen Werten
fur die einzelnen Abteilungen. Wir selektieren Unique Values, geben das Feld
an, figen die Werte hinzu und wahlen eine andere Farbgebung aus. Um eine
Vorschau zu erhalten, wahlen wir , Apply“. Mit ,Accept” bestatigen wir die
Farbauswahl. Die Symbolisierungsmaoglichkeiten sind vielfaltig. Wir kdnnen uns
zum Beispiel die Grillplatze entsprechend ihrer Auslastung darstellen lassen.
Dafiir wahlen wir die ,Graduated Symbols“, wahlen das Feld Auslastung und
klicken auf das aktuelle Darstellungssymbol, um die Farbe und GroRe zu
andern. Dabei sollte man darauf achten, die richtige Einheit auszuwahlen. Als

nachstes miissen wir einen Minimal- und Maximalwert fiir die SymbolgréRe
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angeben. Die Anzahl an Intervallen ist ausreichend, also lassen wir die Intervalle
berechnen. Nach der Bestatigung sehen wir das Ergebnis. Es stehen uns auch
fur einheitliche Werte andere Symbole zur Verfligung, schauen Sie einfach zu,
die Schritte sollten nachvollziehbar sein. So sehen wir auf den ersten Blick, dass

Nistplatze etwas mit Végeln zu tun haben.

Film 6: Transparente Darstellung

In gvSIG erfolgt die Transparenzeinstellung fur Vektor- und Rasterdaten
unterschiedlich. Wir sehen hier eine Abbildung von Spanien als
Vektordatenlayer. Wir fligen nun zwei Rasterdatenlayer hinzu. Dazu wahlen wir
im zundchst leeren Fenster den Treiber flir Rasterdaten aus und bekommen
nun auch Rasterdaten zur Auswahl angezeigt. Nun zoomen wir etwas naher
heran, uns interessiert der Hafen von Valencia. Zunachst deaktivieren wir den
obersten Layer. So sieht der Hafen im Jahr 1980 aus. An dieser Stelle mochte
ich kurz auf die Unterschiede im Kontextmeni eines Layers hinweisen, wenn er
deaktiviert oder aktiviert ist. Wahlen wir im jetzt aktiven Layer die ,Raster
Properties”. Im folgenden Fenster wahlen wir , Transparency” . Nun haben wir
zwei Moglichkeiten: wir kdnnen den Layer insgesamt transparent darstellen;
oder wir verandern die Deckkraft pro Pixel. Hier méchten wir die gesamte
transparente Darstellung. Wir setzen also die Deckkraft auf etwa die Halfte und
schauen uns das Ergebnis an. Man sieht deutlich die Veranderung des Hafens in
den Jahren zwischen 1980 und 2002, in den sich Uberlagernden Bildern.
Verschieben wir nun den Vektordatenlayer an die Spitze des TOC. Dort werden
auch alle Einzelwerte angezeigt, wir suchen nach Valencia. Mit einem
Doppelklick 6ffnen sich die Farbeinstellungen. Wir setzen die Deckkraft

herunter und sehen nur noch die blau schimmernden Grenzlinien.

Film 7: MaRstab und Koordinaten

Die Mal3stabsanzeige informiert uns tGber den aktuellen Mal3stab. Wir kénnen
einen vorgegebenen Malstab wadhlen, zum Beispiel um Ausschnitte eines
Views in eine Karte, die schon Ausschnitte in einem bestimmten MaRstab
enthilt, einzufiigen; oder auch einen beliebigen MaRstab angeben. Andern wir

die Karteneinheiten in den View Properties, hat dies Auswirkungen auf die
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MaRstabsanzeige und die angezeigten Koordinaten. Uber ,View*, ,Properties”,
kénnen wir die Karteneinheiten umstellen. Wahlen wir zunachst Kilometer. In
der MaRstabsanzeige und in der Koordinatenanzeige sehen wir eine Anderung.
Stellen wir nun Millimeter als Karteneinheit ein. Wieder sehen wir eine

Anderung des MaRstabs.

Film 8: Projektionen

Wir sehen hier einen leeren View in unserer bekannten Gauss-Kriiger-
Projektion. Da wir nun einen Layer mit einem anderen rdaumlichen
Referenzsystem hinzufiigen mochten und uns dieses bekannt ist, stellen wir
zunichst die Projektion des Views auf die neue Projektion um. Uber die View-
Properties gelangen wir zu der Auswahl fiir Projektionen. Wir bendétigen die
UTM-Zone 30. Die Einstellungen wurden tGbernommen, wir kénnen also den
neuen Layer hinzufligen. Der Layer wird in korrekter Projektion dargestellt.
Schauen wir doch einmal, was passiert, wenn wir einen Layer mit einem
anderen raumlichen Referenzsystem hinzufligen, ohne die Projektion zu
verandern. Der Layer sieht im Vergleich etwas merkwirdig aus und scheint
auch an einer voéllig falschen Stelle zu liegen. Loschen wir also diesen Layer
wieder und fligen ihn erneut hinzu. Wir sollten uns also fiir die Zukunft merken,
dass auch in gvSIG zwischen der Projektion eines Views, also eines Data
Frames, und der Projektion eines Layers unterschieden wird. Dieses Mal geben
wir im Auswahlfenster des Layers die entsprechende Projektion an. Wir
bendétigen die WGS 84 Projektion. gvSIG gibt uns an dieser Stelle den Hinweis,
dass dieser Layer neu projiziert wird. Die Layer werden nun an derselben

Position abgebildet.

Film 9: Speicherung von Dateipfaden

In gvSIG werden Dateipfade ausschlief3lich absolut gespeichert. Der Ort, an dem
sich ein geladener Datensatz befindet, kann Uber die Layerproperties
herausgefunden werden. Hier wird der Pfad angezeigt. Verwendete Daten
kénnen nicht verschoben oder geléscht werden, solange gvSIG auf sie zugreift.
Um zu zeigen, wie sich ein neuer Pfad fiir die bendtigten Daten angeben ldsst,

schlielen wir zunachst gvSIG. Nun verschieben wir die Datei, welche gerade
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noch als aktiver Layer zu sehen war, in den Ordner ,,neuer Pfad”. Wir miissen
gvSIG nun neu starten. Wir 6ffnen dasselbe Projekt, welches vorhin im View zu
sehen war. Das Programm erkennt, dass Daten fehlen, und fragt uns nach dem
aktuellen Ort. Wir kénnen nun entweder den Pfad per Hand eingeben oder
woanders danach suchen. Wissen wir nicht, wo unsere Daten sind, informiert
uns gvSIG mit diesem kleinen Symbol, dass fir diesen Layer keine Daten mehr

vorhanden sind.

Film 10: Auswahl aus Layern

Bei der Auswahl von Objekten in einem View kénnen immer nur Objekte eines
aktiven Layers ausgewadhlt werden. Hier ist der Nistplatzlayer aktiv. Wir
selektieren Uber ein Auswahlrechteck eine Beliebige Gruppe von Objekten.
Obwohl sich hier mehrere Layer Uberlagern, werden nur Objekte des
Nistplatzlayers ausgewahlt, was auch in der Attributtabelle zu sehen ist. Um die
Auswahl aufzuheben, klicken wir auf das Symbol fir die Aufhebung der
Auswahl. Um Objekte aus mehreren Layern auszuwadhlen, muissen wir die
gewlinschten Layer mit gedriickter Steuerungstaste auswahlen. Mochte man
diese Auswahl dauerhaft beibehalten, ist es moglich, diese Layer Uber das
Kontextmeni zu gruppieren. Die Layer sind nun alle in einer Gruppe, und wir
selektieren wieder beliebige Elemente. Doch zundchst einmal zoomen wir
wieder zur vollen Ausdehnung aller Layer. Nach der Auswahl 6ffnen wir wieder
die Attributtabelle des Nistplatzlayers. Wir sehen, dass die Eintrage selektiert
wurden und auBerdem sdamtliche Attributtabellen der gruppierten Layer

geoffnet wurden.

Film 11: Lokalisation und Selektion

gvSIG verfligt Giber eine grofle Auswahl an Selektionstools. Es wird allerdings
zwischen einer Selektion und einer Lokalisation unterschieden. Wir wollen uns
nun die Funktion Locate by Attributes anschauen, welche wir unter dem Meni
View finden. Dabei ist es ausnahmsweise egal, welcher Layer gerade aktiv ist. In
dem kleinen Fenster miissen wir zunachst den entsprechenden Layer wahlen
und anschlieRend das Feld, sowie den Feldwert auswahlen. Wir wahlen den

Layer Nistplatz, das Feld Vogelart und den Feldwert Felsenschwalbe. Gut, das
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war recht eindeutig. Versuchen wir es mit der Bartmeise. Bei einer Lokalisation
wird die Auswahl nicht hervorgehoben. Es wird lediglich der Bereich, in
welchem sich die Objekte befinden, in grofitmoglichem Zoom angezeigt. Fihrt
man nun diese Abfrage liber die Filterfunktion aus, wird die Auswahl farblich
hervorgehoben. Allerdings miissen wir nun den Layer vorher aktivieren. Um die
Filterfunktion zu nutzen, missen wir zundchst eine Abfrage formulieren. Ich
suche wieder nach der Felsenschwalbe. Bei der Filterfunktion fir Layer handelt
es sich genau genommen um eine Abfrage Gber die Attributtabelle, da auf ihre
Daten zugegriffen wird. Schauen Sie mir noch einmal zu und versuchen Sie die

Schritte nachzuvollziehen.

Film 12: Rdumlich bedingte Auswahl

Wir werden nun eine raumlich bedingte Auswahl durchfiihren. Wir méchten
alle Abteilungen identifizieren, in denen Grillplatze vorhanden sind. Dazu
bendtigen wir die Funktion ,Selection by Layer”. Wir finden sie bei den anderen
Selektionstools im Meni View. Da wir nach den Grillplatzen suchen, miissen
wir diese zundchst auswadhlen. Und da wir im Layer Abteilungen nach ihnen
suchen, muss dieser aktiviert werden. Im folgenden Fenster miissen wir etwas
genauer hinschauen, da es mehrere Selektionsmdglichkeiten gibt. Wir wahlen
flr unseren Zweck , Contain®, da die Grillplatze in den Abteilungen enthalten
sind. AuBerdem miissen wir noch angeben, wonach wir suchen. Wir 6ffnen nun
die Attributtabelle des Abteilungslayers und lassen uns die ausgewadhlten
Eintrage gruppieren. Nun kénnen wir die selektierten Datensatze in eine DBF-
Tabelle exportieren. Dazu missen wir die Tabelle aktivieren und im Meni
,Table”, ,Export to DBF” wahlen. Nachdem wir einen Namen fiir die Tabelle
vergeben haben, kénnen wir die neue Tabelle im Project Manager hinzufligen.
AulRerdem konnen wir ein Shapefile mit den ausgewdhlten Geometrien
erstellen lassen und dem Dokument hinzufiigen. Dies erfolgt Gber das Meni
,Layer”, ,Export to SHP“. Wir benétigen wieder einen Namen fiir das neue
Shapefile. Wir lassen das neue Shapefile dem Dokument hinzufiigen und

schauen uns das Ergebnis an.
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Film 13: Gruppierte Berechnungen

Mdochte man eine gruppierte Berechnung, zum Beispiel eine Summierung, in
gvSIG durchfliihren, muss eine Sache besonders beachtet werden. Probieren wir
erst einmal aus, ob wir herausfinden koénnen, wie viele Nistplatze der
verschiedenen Vogelarten in den einzelnen Abteilungen vorhanden sind. Wir
aktivieren das Tabellenfenster und klicken auf das Symbol , Table Summarize”.
Wir wahlen das Gruppierungsattribut Abteilungen, kénnen im folgenden Feld
jedoch keine Vogelarten auswahlen. Werfen wir also zunachst einen genaueren
Blick auf die Tabelle. Dazu missen wir den Editionsmodus des Layers starten
die Tabelle aktivieren und im Men( Table ,,Manage Fields” anklicken. Das Feld
,Type” sagt uns, dass der Feldtyp der Vogelarten ein String ist, er kann also
auch Buchstaben und nicht ausschlieBlich Zahlen enthalten. Deshalb schlieit
gvSIG solche Felder von vornherein fiir eine statistische Berechnung aus. Als

Gruppierungsattribut sind sie jedoch geeignet.

Film 14: Join-Verkniipfung

Ich méchte nun zeigen, wie man eine Joinverkniipfung in gvSIG machen kann.
Zundchst brauchen wir zwei geeignete Tabellen. Wir erinnern uns, dass bei
gleichzeitig aktiven Layern auch alle zugehdrigen Attributtabellen gedffnet
werden. Die beiden uninteressanten Tabellen schlieRen wir zunachst, und
einigen uns auf das Schlisselattribut ABT. Wir mdchten nun die Informationen
der Grillplatztabelle in der Tabelle des Layers Nistpldatze sehen. So kénnen wir
spater sofort sehen, wo Grillpldatze und Nistpldtze innerhalb einer Abteilung
vorkommen. Dazu klicken wir auf das Join-Symbol und geben als erstes die
Tabelle an, welche wir erweitern mochten. Dann miuissen wir das
Schllsselattribut wahlen und bei Bedarf einen Vorsatz fir die Felder der
erweiterten Tabelle angeben. Als nachstes miissen wir den Layer auswahlen,
dessen Informationen Gbernommen werden sollen. Wir sehen nun bei dieser
sehr Ubersichtlichen Tabelle auf einen Blick, in welchen Abteilungen sich Nist-

und Grillplatze gleichzeitig befinden.
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Film 15: Hinzufiigen von Attributen

Wir moéchten nun die Attributtabelle des Abteilungslayers um ein Feld mit
neuen Eintragen erweitern.

Wir fligen zundchst eine eigenstandige Tabelle zu unserem Projekt hinzu.

Der Editionsmodus fur Attributtabellen eines Layers wird Gber das Layermeni
»Start editing” aufgerufen. Dabei sollte man ein wenig aufpassen, denn der
Layer ist dann ebenfalls editierbar. Fur das Editieren eigenstandiger Tabellen ist

der Start Editing-Knopf unter dem Meni ,Table” zu finden.

Sehen wir uns nun die Feldtypen der Tabelle an. Beide sind String-Felder.
Schauen wir uns nun den Feldtyp der anderen Tabelle an. Hier ist es ein Integer.
Das bedeutet, wir konnen die Tabellen so nicht verknlipfen, da hierfir die

Feldtypen Gbereinstimmen missen.

Wir figen nun der Attributtabelle des Abteilungslayers ein Feld mit Namen
»abt_string® hinzu, und der Typ soll String sein. Wir missen jetzt die Spalte
wahlen, in welche neue Werte eingetragen werden. AnschlieRend klicken wir
auf das Symbol ,Expression”. Als Expression, also Ausdruck, kdnnen wir eine
Formel eingeben, oder wie in diesem Fall einfach die Werte aus der anderen
Spalte Ubertragen. Mit ,Finish Editing” und anschlieBender Bestatigung werden

die Anderungen iibernommen.

Film 16: Import von Exceltabellen iiber ODBC

Es existiert auch in gvSIG eine, wenn auch etwas umstandliche, Mdéglichkeit, um
Lesezugriff auf Excel-Tabellen zu erhalten. Gehen wir ganz langsam Schritt fur
Schritt vor. Zuerst missen wir wissen, wo sich die Datei befindet und welches
Tabellenblatt wir bendtigen. Nun 6ffnen wir tiber das Meni Systemsteuerung
den Ordner Verwaltung. Dort wahlen wir mit einem Doppelklick Datenquellen
(ODBC). Wir mochten eine Datenquelle hinzufiigen und wahlen einen
beliebigen Exceltreiber aus der Liste. Im Datenquellennamen sowie in der
Beschreibung geben wir ,,odbc_baumarten” an und wahlen anschlieend tber

»Arbeitsmappe” die Tabelle aus. Wir bestatigen dreimal und rufen gvSIG wieder
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auf. Wir fligen eine neue Tabelle hinzu, diesmal unter dem Punkt Data Base.
Unter ,Data Base” geben wir den Namen der gerade erstellten Verbindung an.
Unter , Table” geben wir das Tabellenblatt an. Dieses muss am Ende mit einem
Dollarzeichen versehen werden und aullerdem in eckigen Klammern
angegeben werden. Die Tabelle konnte erfolgreich geladen werden. Uber
,Table” ,Export to DBF“ kdnnen wir die Tabelle in ein les- und beschreibbares

Dokument umwandeln.

Film 17: Relate-Verkniipfung

Wir wollen nun eine Link-Verkniipfung erstellen. Diese Funktion ist Ihnen
vielleicht als Relate bekannt. Dazu missen wir zundchst wieder ein Attribut
erzeugen, und dieses Attribut mit bestimmten Werten fillen. Starten wir den
Editionsmodus flr die Baumartentabelle. Im Field Manager erzeugen wir ein
neues Attribut, mit Namen ,,abt_int“ vom Typ Integer. Nun mdéchten wir die, im
Typ String vorliegenden Abteilungsnummern, in die neuen Felder vom Typ
Integer Gbertragen. Dazu nutzen wir die Funktion ,To Number” des Expression
Calculators. Wir selektieren zuerst das Attribut, welches libertragen werden
soll, und wahlen anschlieBend den Befehl aus. Die Nummern wurden
Ubertragen, wir konnen die Tabellen nun verlinken. Dazu klicken wir zunachst
auf das Symbol. Links werden von gvSIG nur in eine Richtung erstellt, wir
konnen also nicht beliebige Abfragen durchfiihren. Vielmehr missen alle
Abfragen von der zuerst eingegebenen Tabelle ausgehen. Deshalb sollte man
sich vorher Gedanken dariiber machen, welche Abfrage man durchfiihren
mochte. Wir mochten wissen, welche Baumarten in unseren Abteilungen
vorhanden sind. Also fihren wir die Verlinkung von der Attributtabelle des
Abteilungslayers aus. Als Schlisselattribut, wahlen wir das Attribut ,ABT“. In
der Baumartentabelle ist es das soeben erstellte Attribut ,,abt_int“. Wir wahlen
ein paar Eintrage willklrlich aus — der Link funktioniert also. Selektieren wir nun
auf der Ansicht einige Flachen, um zu sehen, welche Baume dort wachsen. Zu

den ausgewahlten Flachen, werden die Baumarten angezeigt.
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Film 18: Geoprocessing Toolbox und SEXTANTE

Wir haben in gvSIG auch einige Geoprocessing-Werkzeuge zur Verfligung.
Diese sind in der Geoprocess Toolbox gesammelt. Sie sind nicht sehr
umfangreich, aber geben jeweils am rechten Rand eine kleine Erklarung,
worum es bei der Anwendung geht, wie z.B. hier, bei dem Befehl Dissolve. Eine
weit groBere Auswahl stellt die Erweiterung SEXTANTE bereit. Hier sind auch
alle Tools enthalten, welche wir in der Geoprocess Toolbox finden. Eine
Suchfunktion ist ebenfalls vorhanden, und der Befehl Dissolve hat hier sogar
noch eine Erweiterung. Wir werden spdter noch sehen, wozu die

verschiedenen Tools verwendet werden kénnen.

Film 19: Dissolve

Nachdem wir den Befehl Dissolve nun gesehen haben, wollen wir ihn auch
verwenden. Jedoch missen wir zuvor wieder die Tabelle modifizieren, dazu
gleich mehr. Zundchst erstellen wir ein Feld mit einem beliebigen Typ. Die
einzige Bedingung ist, dass alle Werte gleich sind. Deshalb geben wir hier einen
Defaultwert von 1 an. Das hat geklappt, also konnen wir nun den Dissolve-
Befehl ausfiihren.  Wir missen jedoch vorher noch den Editionsmodus
ausschalten. Wir 6ffnen die Geoprocess Toolbox und wahlen Dissolve. Wir
starten den Prozess Uber ,Open Geoprocess”. Wir suchen den Abteilungslayer
und wahlen das gerade erstellte Attribut Dissolve. Nachdem wir einen Namen
fur das Ausgabeshapefile angegeben haben, wollen wir starten. Das Ergebnis
sieht gut aus, werfen wir einen Blick in die Attributtabelle des neuen Layers. Es
wurden durch diesen Prozess samtliche Geometrien Uber das Attribut
,Dissolve” vereint. Deshalb war es vorher noétig, das neue Attribut zu
definieren, da gvSIG von selbst keine verallgemeinernden Angaben wie

beispielsweise den Geometrietyp in den Attributtabellen speichert.

Film 20: Polygon to Polyline

Wir werden jetzt einen Befehl aus SEXTANTE verwenden. Wir mdchten die
Umrisse der gerade erzeugten Geometrie in Form eines Linien-Shapefiles
speichern. Erzeugen wir also zundchst ein leeres Linienshapefile tber ,View",

»New Layer”. Wir wahlen die Art der Geometrie und einen Namen aus. Der
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Befehl Polygon to Polyline, welcher unter ,Tools for Polygon layer” zu finden
ist, ermodglicht unser Vorhaben. Dieser Geoprozess bendtigt lediglich das
Ausgangsshapefile, sowie ein Ziel- Linien-shapefile. Geben wir hier keinen
Namen an, wird die berechnete Geometrie in einer temporaren Datei
gespeichert. In unserem Fall war die Berechnung erfolgreich. Offnen wir die
Properties, sehen wir, dass das Shapefile unter dem gewiinschten Namen

gespeichert und ein Linienshapefile ist.

Anhang 3: Zusammenfassung der Untersuchung der
Lehrfilme (Vorlage) sowie der Aufgabenbearbeitung der

Ubungsaufgaben mit gvSIG 1.9 RC

1. Offnen von ArcCatalog

- Offnen von gvSIG

Angabe der Sprache ,Englisch”, da Ubersetzung nicht abgeschlossen.

2. Erstellen einer Verzeichnisverkniipfung

—>Angabe der Standardverzeichnisse flr Projekte, geographische Daten,
Vorlagen und Symbole

Offnen der Preferences—=> General=>Folders

Hinsichtlich folgender Aufgaben wdre es an dieser Stelle sinnvoll, die
Rahmenbedingungen fir das weitere Arbeiten innerhalb der Preferences

festzulegen:

e Definition des GKZ3-Kosys fiur den Standard-View (EPSG, Search by
CODE: 31467)

e Standardfarbe fur Auswahl: Rot (RGB: 255,0,0)
e Standardfillfarbe: Zufallig (aleatory)

e DBF CHARSET: utf-8
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* Neustart des Programms, damit Anderungen (ibernommen werden

3. Kopieren der Ubungsdaten/ 4. Datenvorschau

- Entfillt

5. Offnen von ArcMap, 6. Offnen eines existierenden Dokuments, 7.

Speichern eines Dokuments

Im Projektmanager wird View selektiert->New—>Selektieren des
Views—>Rename in ,,...”

File=>Open Project>Auswahl der Projektdatei

File>Save as... oder Save Project->Angabe von Name und Ort

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Starten von ArcMap
» Offnen einer neuen leeren Karte bzw. einer bestehenden Karte
» Speicherung von Karten

8. Werkzeugleisten

—>Ausprobieren und Tool Tips fir die angezeigten Werkzeugleisten, Verwenden
des , Information” Tools flr norddstlichen Biotoppunkt
e Passende Werkzeugleisten werden von gvSIG automatisch

entsprechend dem aktiven Fenster zur Verfiigung gestellt

e Konnen jedoch auch manuell ein- und ausgeschaltet und platziert

werden

e Zur Verwendung des Information-Tools ist der Layer, welcher die

Geometrie enthalt, zu aktivieren

e Werkzeuge thematisch in Werkzeugleisten zusammengefasst

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Hervorhebung der Standardwerkzeugleisten (Standard + Tools)
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» Hinzufugen/Entfernen einer neuen Werkzeugleiste

9. Bedeutung und Verwendung des TOC

->Aktivieren und Deaktivieren von Layern, Anderung der Reihenfolge sowie

Zoom to Layer analog zum Vorgehen in ArcMap

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Layer-Darstellung
» Reihenfolge von Layern
> Auswirkungen einer Verschiebung von Layern innerhalb des TOC

10. Hinzufiigen und Entfernen von Layern

—>Add Layer—>Auswahl des Treibers—>Auswahl des Layers
—>Layer aktivieren>rMT Layer—> Delete

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Hervorhebung TOC, Erlduterungen

Verschiebung der Reihenfolge von Layern im TOC
Aktivierung von Layern

»,Zoom to Layer”

Hinzufligen eines Layers zu einem Data Frame im TOC

YV V V V V

Loschen eines Layers

11. Layer-Eigenschaften-Symbolisierung

—>Doppelklick auf den jeweiligen Layer; Einfirben eines Layers nach
»,Categories-Unique Values” sowie des anderen Layers nach “Quantities-
Graduated Symbols” (6 Klassen), bezogen auf das Attribut NAT; Flachen mit
NAT=999 in weil darstellen.

e Symbolisierungsmoglichkeiten stehen nur fir Vektordaten zur

Verfligung.

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Aktuelle farbliche Symbolisierung eines Layers

» Layer-Properties = Symbology

» Darstellung als einzelne Symbole, Kategorien, fortlaufende
Abstufungen
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» Einzelwerte vs Klassen(Hangneigung/Abteilungen)
» Farbgebung Uber die Color Ramp

12. Layer-Eigenschaften-Transparenz

Rasterdaten: rMT layer->Transparency—>Opacity (Lichtundurchlassigkeit)
Vektordaten: Symbology—>Einstellen der Transparenz fir jede einzelne

Symbolisierung

e Flr Rasterdaten: Transparente Darstellung entweder ,per Pixel”
(Transparenz eines aus den RGB-Farben zusammengesetzten Farbtons)

oder ,,Opacity” (Lichtundurchlassigkeit)

e Fur Vektordaten: Vektordaten kdnnen nur in der “Unique Values”-Option

transparent dargestellt werden.

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise

werden gegeben?):

» Gleichzeitige Betrachtung zweier Layer, bzw. deren

Uberschneidungsflichen hiufig wichtig

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Problem sichtbar machen
» Einstellen der Transparenz in den Properties

13. Layer-Eigenschaften-Beschriftung

- Symbology—>Labeling—>Beschriften des Biotoppunkte-Layers mit Attribut-

werten aus ,Id“

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Properties > Labels
» Beschriftungsbeispiele

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Erlauterungen zur sinnvollen Beschriftung
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14. Angabe des Maf3stabs

—>Das Shapefile ,Biotoplinien” wird dem View hinzugefiigt, Anordnung der
Layer zum Testen der Scale Range, Eingabe der Scale Range 1:25000 und
Eingabe eines Mal3stabs von 1:30000

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Manuelle Eingabe eines Mal3stabs

» Leere MaRstabsanzeige, wenn Data Frame kein KoSys zugeordnet ist
» Ermittlung des Aktuellen KoSys

» Aufruf der Online-Hilfe und suche nach ,map scale”

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Einfluss des MaRstabs auf Darstellung des Karteninhalts

15. Online-Hilfe
- Nicht verfugbar in gvSIG 1.9 RC.

16. Umgang mit Datenrahmen

—>Erstellen eines View

e Data Frame = View
e Moglichkeit, die Navigation innerhalb gvSIG vorzustellen, Fenstermodus

e Anlegen mehrerer Views und das parallele Arbeiten mit den

verschiedenen Views.

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Hervorhebung des Data Frames im TOC
» Einfligen eines neuen Data Frames und Hervorhebung der
automatischen Aktivierung

A\

Aktivierung des ,alten” Data Frames

» Aktivierung und Hinzufligen von Layern in den ,neuen” Data Frame
durch drag&drop aus anderen DF’s

» Loschen des neuen Data Frames
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Formulierung des Sprechtextes (Welche Erganzungen und Hinweise

werden gegeben?):

>

A\

Data Frame legt Darstellungseigenschaften fur einen oder mehrere
Layer, wie KoSys oder geograph. Ausdehnung fest

DF ist Ubergeordneter Rahmen fiir Layer

Um Layer hinzufugen zu kdnnen, muss DF aktiv sein

Bei Entfernung eines DF bleiben die Geodatensatze erhalten

17. Data Frame-Eigenschaften, KoSys

—1n gvSIG liegt jedem View eine Projektion zugrunde.

>

Die aktuelle Projektion wird in der rechten unteren Ecke angezeigt.
Es handelt sich dabei um einen Default-Wert, der angepasst werden

kann.

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

>
>

YV V V V

Erklarung DF und Layer

Aktuelles KoSys DF: rMT layer=> ,Properties“> Coordinate
System—> Evtl andern des KoSys

Akt. KoSys Layer: ,Properties“—> ,Source”

Uberpriifen der KoSys des jeweiligen Layers aus einem der drei DF
Unterschied der GK-Projektion zur WGS

Alle Layer in einen DF mit GK System-> Darstellung der
verschiedenen Projektionen

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise

werden gegeben?):

>
>
>
>

>

Unterscheidung der Eigenschaften eines DF und eines Layers
Erklarung DF und Layer

DF dbernimmt automatisch KoSys des ersten hinzugefligten
Geodatensatzes

KoSys eines DF wahlbar, das eines Layers nicht, es wird vom
zugrundeliegenden Geodatensatz bestimmt

Die Wahl der Projektion beeinflusst die Darstellung

18. Layer-Eigenschaften-KoSys

e Die Geodaten geladener Layer, denen ein anderes Koordinatensystem

zugrunde liegt, werden projiziert dargestellt.
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e Um einen Layer in der richtigen Projektion zu laden, muss bei der Wahl

des Layers die richtige Projektion angegeben werden

e Esist auch moglich, das Projektionssystem eines Views zu andern.

e gvSIG verfugt aullerdem Uber einen ,Reprojection“-Geoprozess,
welcher es ermdglicht, Daten mit verschiedenen Projektionen innerhalb

eines Projekts zu vereinen.

e Wenn ein geladener Layer ein anderes KoSys verwendet als der View, ist

der MaRstab ,,0“ angegeben.

19. Relative/absolute Pfade

> manuelle Anderung von Dokumenten-Pfaden

® |n gvSIG werden samtliche Pfade absolut gespeichert

e Werden Daten verschoben, geldscht etc. wird beim ersten Aufruf dieser

Daten, nach dem Pfad gefragt.

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Anzeigen des Ortes, wo die Geodaten sind

» Rotes Ausrufezeichen markiert die fehlerhafte Verkniipfung

» Erneuern von Pfaden—>Properties—> ,Set data Source”

» Anzeigen der Projekteigenschaften> ,File“> ,Document
Properties”

» Aufruf ,,Data Source Options“

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Geometrien kdnnen aus Karte geléscht werden-->wird nicht mehr
im TOC angezeigt

» Nur Verweis auf Datensatz wird im Layer gespeichert, nicht die
Daten selber

» Loschen, Umbenennen, Verschieben etc. fuhrt dazu, dass die
Geometrie nicht mehr angezeigt wird>Der Verweis auf die
Datenquelle wird nicht automatisch gedandert

» Name von Datensatz und Geometrie muss nicht Gbereinstimmen

» Erlauterung absolute und relative Pfade

A\

Empfehlung fir relative Pfade
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20. Manuelle Auswahl von Objekten/21. Angabe der auswdhlbaren

Layer

—>Auswahl von Objekten Uber Aufziehen einer Auswahlbox, aus mehreren
Layern und aus einzelnen Layern

e Select by Point, by rectangle, by polygon, by polyline, by circle.

e Select by Bufferzone, invert selection, Clear selection, select all, (select

by layer).

e Die Auswahl Giber ein Rechteck funktioniert problemlos in einzelnen und

mehreren Layern.

e StandardmaBig werden nur Elemente des aktiven Layers selektiert.

¢ Man kann mehrere Layer aktivieren oder auch zu Gruppen
zusammenfassen. In diesen Fallen werden Elemente aus mehreren

Layern ausgewahlt.

e Wird eine Auswahl nicht aufgehoben, so bleibt sie bestehen, auch wenn

der Layer deaktiviert wird.

Angewendete Vorgehensweise (Was wird im Beispielvideo (20)
gezeigt?):

» Demonstration Select Features Tool

» Auswahl durch Auswahlbox oder einzeln bei gedriickter Shifttaste

» Loschen der Auswahl eines speziellen Layers: rMT Layer—>
Selection—> ,Clear selected features”

» Loschen aller Selektionen:

» 1. Klick in Bereich ohne Geometrie bei aktivem Select Features Tool

» 2. Nutzen des Clear selected Features Tool

» Auswahl aller Elemente eines Layers : rMT Layer—> Selection—>
“Select all”

» Die Selektion last sich auch umkehren Selection> ,Switch

Selection”

» Zoom in Bereich der Selektion eines Layers: rMT Layer—> Selection
- ,Zoom to selected Features”

» Die Auswabhl aller Layer last sich bei aktivem Select features Tool mit
rMT-> ,Zoom to selected Features”
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Angewendete Vorgehensweise (Was wird im Beispielvideo (21)
gezeigt?):

» Auswahl beider Beispiellayer

» Darstellung der zuséatzlichen Auswahl eines nicht benétigten Layers

» Angabe der auswahlbaren Layer: ,Selection“>Set Selectable
Layers—>Deselektion des unerwiinschten Layers

» Aufheben der Auswahl fiir alle Layer

» Bei erneuter Auswahl wird der nicht auswahlbare Layer nicht
beriicksichtigt

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Prinzipiell alle Layer auswahlbar sofern sichtbar und keine
Rasterdaten

22.Sachdatenbezogene Auswahl von Objekten

—>Selektion aufgrund bestimmter Attribute/Attributwerte

- Filter-> Abfrage formulieren: ,, ID=830“

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Selection>“Select by Attributes”
Layer auswahlen, ,Method“ bestimmen—>New Selection
Attribut auswahlen und Abfrage formulieren: ,Perimeter” >2000

YV V V

Um sich alle Werte anzeigen zu lassen = ,get unique values” (zur
Uberpriifung der Auswahl sinnvoll)
» Alle selektierten Objekte werden markiert

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Abfrage mittels mathematisch formulierter Bedingungen

23. Attributtabellen

—2>Aufruf der Attributtabelle, Sortieren der markierten Eintrage, willkiirliche
Auswahl von Attributen, Auswahl bestimmter Attribute: Filterabfrage ,1D=830

or ID=827"

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Layer—> “Open Attribute Table”
» Mit rechter MT auf Attribut—> Optionen fur dieses Attribut
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» Markieren eines Objektes durch Anwéahlen der Zeile (strg=>mehrere
Objekte)

» Knopf ,Options“—>Select by Attributes

Abfrage nach Flache >20000; Anzeige von selektierten Objekten -

,Selected”

» Options—> ,Export”“ Ausgabetabelle wird erstellt

A\

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Eigenschaften des Layers in der Attributtabelle hinterlegt

» Eine Zeile fiir jedes Objekt

» Attributoptionen beispielhaft erklaren

>

Bei Ausgabe einer neuen Tabelle alle oder nur selektierte
Datensatze exportieren

24. Raumlich bedingte Auswahl von Objekten

Selektion in Layer Biotoppunkte—>aktivieren Biotopflichen—>Abfrage
formulieren (Selection by Layer)>Offnen der Attributtabelle Biotop-
flachen—>Table—>Export to DBF

e Export der Selektion ist abhdngig vom aktiven Layer

(Line/Polygon/Point)

e Exportiert man z.B. die selektierten Features (bezogen auf Aufg. 24) aus
dem Biotopflachenlayer (Polygon-Layer/shp), erhdlt man als

Attributtabellenwerte die FlachengréRe der selektierten Flachen.

e Exportiert man aus den Biotoppunkten (Punkt-Layer/shp), erhdlt man

als Tabelle die ID-Werte der sieben ausgewadhlten Biotoppunkte.

e gvSIG erstellt keinen Index bei der Erstellung von Tabellen(FID/0ID)

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Betroffene Layer identifizieren und aktivieren

Selection—> ,Select by Location” = ,select features from*
Angabe der Layer: “Grillplatze”

Festlegung der Operation, = “are in distance of”

YV V VYV

Auswahl des anderen betreffenden Layers: ,Nistplatze” und Eingabe
der Distanz (Buffer)
Hervorhebung der zwei selektierten Objekte

A\
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>
>

Layer Properties = ,,Export Data“
Darstellung des neuen Shapefiles

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise

werden gegeben?):

>
>

Selektion der Layer in Abh. von der Frage
Automatische Shapefile Erstellung

25. Export von Objekten in eine neue Feature Class

—>Export der in Aufg. 24 selektierten Features in eine neue Feature Class

(Shapefile)

e Layer mit der Selektion muss aktiv sein—>Layer—>Export to SHP

26. Gruppierte Berechnung einfacher statistischer Kennzahlen

Vorher Auswahl aufheben! Attributtabelle der Biotopflachen 6ffnen—>Table

summarize>Eingabe der Berechnung.

e gVvSIG ersetzt die Bezeichnung ,NAT” durch die Bezeichnung ,,Group” in

der neu erstellten Tabelle!

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

>
>

>
>

>

Offnen der Attributtabelle des Layers

Aufruf von Summarize (ber die Optionen (Rechtsklick) einer
beliebigen Spalte der Tabelle

Festlegung des Gruppierungsattrinutes und Auswahl der Kennzahlen
Hinzufiigen der Tabelle im Baumart-Layer (TOC ist im Source-
Modus)

Offnen der Tabelle und Erkldrung der Attribute

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise

werden gegeben?):

>

>

Zundchst Festlegung des Gruppierungsattributs, danach Festlegung
des Analyseattributs

Ablage der Tabelle im TOC im Baumarten-Layer, auch wenn die
Tabelle mit dem shp nichts zu tun hat

Die Tabelle ist ohne Geometriebezug, enthdlt fur jede
zusammengefasste Gruppe eine Zeile

48



27. Erstellen einer Join-Verkniipfung

e gvSIG akzeptiert nur Schllsselfelder des gleichen Typs fiir einen Join,

man muss sich die Tabelle also ,,zurechtbasteln”.

e Der area_nat-Tabelle wird ein Feld vom Typ INTEGER (da das NAT-Feld

der Biotopflachen-Tabelle diesen Typ besitzt) hinzugefigt.

® |In

die Felder der neu erstellten Spalte werden die NAT-Werte

Ubertragen, so ist der Join moglich.

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

>

A\ YV V VYV

A\

Offnen der Tabellen ,Abteilung” und ,Baumarten”

Verknlpfendes Attribut ist Abt_ID bei einer 1:1 Verkniipfung

Rechte MT Abteilungen = ,Joins and Relates” = ,,Join”

Angabe, was zur Tabelle angefligt werden soll = ,Join attributes
from a table”

Angabe Schllsselattribut und Angabe der zu verknlpfenden Tabelle
inkl. Schllsselattribut

Darstellung der erweiterten Attributtabelle ,,Abteilungen”

Loschen des Joins =>rMT Abteilungen - Joins and Relates >
,Remove Joins”

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise

werden gegeben?):

>

A\

Verknlpfungen fligen einer Tabelle weitere Attribute aus einer
Bezugstabelle hinzu

Unumgadnglich fir eine Verknlpfung ist die Existenz eines
Schlisselattributs, welches in beiden Tabellen vorkommt
Attributnamen werden erweitert

Selektierte Eintrage sind bei dieser Art der Tabellenverknipfungen
irrelevant

28. Hinzufiigen /Léschen von Attributen

—>Hinzufligen eines neuen Feldes, Angabe von Typ und Name

Eigenstandige Tabelle>“Table“—> ,Start Editing“—>Table—>“Manage Fields”

Manage Fields—>New Field; Eingabe Name, Typ: Double, Length: 6, Precision: 3.
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e Der Editionsmodus fiur Attributtabellen eines Layers wird tber ,Start
editing” des Layers aufgerufen (Vorsicht: der Layer ist so auch

editierbar!).

e Fir das Editieren eigenstandiger Tabellen ist der Start editing-Knopf

unter ,Table“ zu finden.

e gvSIG trennt bestehende Join/Link Verbindungen, bevor der
Editionsmodus gestartet werden kann. Es ist also sinnvoll, vor dem
Einflgen eines neuen Feldes die Datensdtze in eine eigenstandige

Tabelle/Shapefile zu exportieren.

e Die vorher durch Join hinzugefligten Felder werden mit dem Vorsatz

,Link“ versehen.

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

> Offnen der Baumarten Tabelle

» Options > ,Add Field“, Eingabe des Attributnamens und
Bestimmung des Typs: Baume_Abt > Short Integer > Precision =
10

rMT Attribut = ,Field Calculator”, Felder und Funktionen werden
hervorgehoben

Eingabe: Baume_Abt= Area/10000*Baume_ha

Neues Feld in Tabelle, welches Baume pro Abteilung enthalt

Loschen des Feldes: rMT = ,,Delete Field”

Weiteres Beispiel mit Flachenumfang Uber Funktion rMT
Umfang—>, Calculate Geometry“

A\

YV V V V

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Hinzugefligtes Attribut ist fester Bestandteil der Tabelle

29. Berechnung von Attributwerten

—>Formulieren einer Berechnung fiir das neu erstellte Feld
Markieren des Feldes—>”Field”>”Expression”; Eingabe der Berechnung:

[area]/[link_area_]*100
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e Der Typ ,Double” wurde verwendet, da der Typ ,Integer” keine
Nachkommazahlen darstellt. Es wurden wahrend des Editionsmodus

mehr als die eingegebenen 3 Ziffern hinter dem Komma angezeigt.

e Nach dem Beenden des Editionsmodus wurden die Werte entsprechend

den Vorgaben gerundet.

30. Hinzu /Entf. von Tabellen ohne Geometriebezug

—>Loschen der Join-Verkniipfung, Laden einer neuen Excel-Tabelle

Aktivieren der Tabelle>Table=> ,Remove Joins”

Excel-Tabellen kénnen in gvSIG nicht direkt gedffnet werden. Uber eine ODBC-

Verbindung kann man lesenden Zugriff auf die Daten bekommen:

Windows-Desktop Oberflache:

Start—>Systemsteuerung—>Verwaltung—> Datenquellen (ODBC)-> Hinzufligen

—>Excel-Treiber auswahlen—>Datenquellenname und Beschreibung angeben

sowie Ort der Tabelle wihlen—=> OK
In gvSIG: Table>New—>Data Base

—>Angabe der Beschreibung (Data base) und Angabe des Tabellenblatts in der
Form[NAMES]=>OK

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Einlesen der Tabelle Gber add Data
» TOC —>Source: Tabelle wird angezeigt

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» ArcMap unterstitzt mehrere Tabellenformate. Wird eines nicht
unterstitzt, kann es nicht eingelesen werden

31. Relate-Verkniipfung

—>Export der Excel-Tabelle in eine DBF-Tabelle, verknlipfen der Tabellen per

Relate Uber geeignetes Attribut, verschiedene Abfragen.
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—>Aktivieren der Tabelle und Export—>to DBF

->Start

editing  Layer—>Attributtabelle>manage  fields>new field:

NUMDB,Type: Double

->Field calculator->Eingabe fiir Attribut NUMDB: NUM (Ubernahme der Werte

des Attributs NUM)->Delete Field “NUM”->Rename Field NUMDB=NUM

o Als

verkniipfendes Attribut wurde NUM(Forsteinrichtungsflache)

gewahlt. Link: ,,Origin Table of the Join“: fei-sachdaten

e Linkabfragen sind nur in ,eine Richtung” mdoglich, d.h. die Tabelle

(Source), von welcher aus der Link installiert wurde, ist auch die Tabelle,

in welcher die Abfrage formuliert werden muss. ,Verwandte” Eintrage

werden dann in der verlinkten Tabelle (Target) selektiert.

e Umgekehrt werden keine ,verwandten Eintrage angezeigt.

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

>

>

Verknilpfen der Tabelle Abteilung mit Informationen aus der Tabelle
Nistplatze

Offnen beider Tabellen = Schliisselattribut: Abteilungen

In beiden Spalten kommen dieselben Werte verschieden haufig vor
- n:m-Verknupfung

Relate-Verknlpfung: rMT Layer, Joins and Relates > Relate

Eingabe: Verkn. Attribut->Verkniipfte Tabelle (Nistplatz) = Verkn.
Attribut

Offnen der Abteilungen-Tabelle > Options = “Related Tables” zeigt
Verknlpfung an

Auswahlen eines Objektes (IMT) und Aufruf der Verkniipfung

Es werden alle verkniipften Elemente automatisch ausgewahlt und
grafisch dargestellt

Loschen aller ausgewahlten Objekte und Aufruf der Nistplatze-
Tabelle, um die Abfrage andersherum auszufiihren

rMT Layer, Joins and Relates = ,, Remove Relates”

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise

werden gegeben?):

>

Relate-Verknipfungen funktionieren in beide Richtungen
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» Hier Art der Abfrage n:m, da in beiden Tabellen gleiche Werte
mehrfach vorkommen

32. ArcToolbox und Kommandozeile

- Offnen der Geoprocess Toolbox, Hinweis auf Eingabezeile im Editiermodus,
Offnen der Sextante Erweiterung

—>Layer Aktivieren->Geoprocess Toolbox; Start Editing

—>Klick auf Sextante—>Vorstellen der Oberflache

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Aufruf der Window—> ,,ArcToolbox“ und Aufruf der Command Line

» ,Search”:,Polygon to Line“ und Auswahl des Tools

» Eingabe Input Features: Layer mit zu bearbeitenden Objekten und
Speicherort

» Hinweis auf Meldung , Befehl erfolgreich ausgefiihrt“ und Protokoll
in der Command Line

» Anzeige des neuen Layers und Aufruf der Attr.tabelle - Mehr
Eintrage sowie leftID und rightID

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Erlauterungen zu Funktionen der ArcToolbox und der Command Line
» Suche aufgrund der Vielzahl von Befehlen sinnvoll = Einordnung
von Polygon to Line in den ArcToolbox-Kontext

33. Konvertieren von Flachen- zu Liniengeometrien

—>Konvertieren eines Polygon-Shapefiles in ein Linien-Shapefile unter
Verwendung des Befehls ,Polygon to Polyline” der Sextante

e gvSIG libernimmt die Werte der ,alten” Tabelle.

34 Manuelle Editierung von Geodaten und Sachdaten

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Aufruf der Editiertoolbar—> , Editor”
» Unter Options Einstellungen der ,,Snapping Toleranz” auf 20 [map
units]

A\

,Start Editing”“—> Verzeichnisangabe und Layerauswabhl
» ,Snapping”“ > Snap-Elemente und Edit sketches auswahlen
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> Offnen Attr.tabelle des zu editierenden Layers

» Demonstration ,,Split tool“: Auswahl der Linie = ,,Split Tool” mit IMT
oder Doppelklick und Mdoglichkeit, die Linie in der Tabelle zu
benennen

» Zusammenfiigen: Auswahl mehrerer Objekte durch Auswahlbox =
»Merge”; Angabe des Objekts an welches das Feature angefligt
werden soll, Anzeige in der Kartenansicht

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Verschiedene Voreinstellungen unter Options (im Editor)
» Erlauterungen zu Snapping-Einstellungen

35. Konvertieren von Geodaten

e Export in shp moglich aber feature class und mdb kann nicht gedffnet

werden

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» ArcToolbox - Feature Class to Shapefile (Conversion Tools)
» Eingabe Input Features: Layer und Output: Verzeichnis
> Offnen der Layer-Properties um Coverage/Shapefile zu erkennen

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Manuelle Bearbeitung von Coverages nicht moglich, deshalb
Shapefile

» Erzeugtes Shapefile muss manuell geladen werden

» Beide Layer sehen in Kartenansicht gleich aus

36. Erstellen einer neuen Feature Class

—Im Sinne der Aufgabe nicht moglich

e Erstellen einer Liniengeometrie (Autobahn) und speichern als Shapefile.

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» ArcCatalog: Wahl des Verzeichnisses, in welchem Shapefile erstellt
werden soll
» File>New—>Shapefile, Name, Feature Type, (KoSys)
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37.Berechnung von Fliche, Linge...

—>Measure Distances der gerade erstellten Liniengeometrie

38. Ridumliche Operationen und Analysewerkzeuge - Vorbereitung

—>fei-sachdaten: Berechnung von Minimum fir ,,NUM“ (Summarize) gruppiert
fir Num_Ba
—>Ausgabetabelle: Gruppiert nach Num_Min summieren der Num_Ba (jetzt

GROUP)

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Auswahl des Gruppierungsattributs = rMT: Summarize
» Angabe weiterer Analyseattribute und Funktionen
» Aufruf der neu erstellten Tabelle

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Summarize: Zusammenfassen von Attributen anhand eines
Gruppierungsattributes

» Gruppierungsattribut: ein oder mehrere Attributwerte sollten
mehrfach vorkommen

» Hinweis auf Attribut ,,count_pkr“ >objekte pro pkr

39. Dissolve, Polygon to Line

—>Erstellen einer Polygongeometrie mit den gleichen Grenzflaichen wie das
zugrunde liegende Shapefile. Umwandlung dieser Geometrien in ein
AulRenlinien-Geometrien-Shapefile

—>SEXTANTE->Polygon to Polyline

e Vor dem Verwenden von Sextanteoperationen (gvSIG 1.9 RC) erst ein
entsprechendes leeres shp erstellen, und dieses dann als Zieldatei

auswahlen.

e Bevor die flachigen Polygone erstellt werden kénnen, muss die Tabelle
modifiziert werden, um ein Feld zu erhalten, nach dem “dissolved”

werden kann (default value=1).
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Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Arc-Toolbox = ,Dissolve”

» Input Feature: Ausgangsshapefile

» Anwahlen der Attribute, welche zusammengefasst werden sollen,
sollen alle Attribute zusammengefasst werden, nichts auswahlen

» Optionale Einstellung: Statistics Fields=> Area—>Summieren

» Darstellung des Dissolve-Ergebnisses

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Wenn Informationen aus der Attributtabelle des Ausgangsshapefiles
im neuen Shapefile enthalten sein sollen, muss dies im ,,Statistics
Field“ angegeben werden

» Hier sollen die einzelnen Flachen zusammengefasst werden

40. Buffer
—>Versehen des gerade erstellten AuRenlinienshapefile mit einer Pufferzone

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Demonstration des Buffer Tools

» Auswahlen der Input Features (Layer: line, polygon...)

» Einstellen der Pufferbreite: 10m, Side Type: Full

» Dissolve Type: Verschmelzen von sich iberlagernden Geometrien

41. Clip

- “Weg-Clippen“ der duleren Pufferzone

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Demonstration des Tools Clip
» Input Features (Daten sollen extrahiert werden) und Clip Features
(Layer mit ,,Ausstechform“-Funktion)

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Wichtig ist die Wahl der richtigen Input und Clip Layer

42. Union, Identity, Intersect

—>Verschneiden der Geometrie mit einer anderen Geometrie Uber Union
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Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

>

Darstellung Union: Zusammenfiigen aller Informationen mehrerer
Datensatze in einer neuen Feature Class. Zur Orientierung werden
die Zugehorigkeiten in der Attributtabelle eingetragen. Hier gibt das
Feld ,FID_SEE“ Auskunft Uber die Lagebeziehung zwischen den
Layern. Punktgeometrien kdnnen nicht verarbeitet werden
Darstellung Identity: Welche Features eines Layers sind in einer
anderen Feature Class enthalten? Input Nistplatze, Identity Features
muissen Polygone sein, Punktgeometrien konnen verarbeitet
werden.

Darstellung Intersect: Wie ldentity, jedoch nicht auf den gesamten
Bereich der Layer bezogen, sondern nur auf den
Uberschneidungsbereich

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise

werden gegeben?):

>

Union: Liegt ein Objekt nur zum Teil im Uberschneidungsbereich,
wird dieses in der Attributtabelle in zwei Flachen geteilt, welche
anhand fid_see unterschieden werden kdnnen

Identity: Alle Nistplatze werden in Tabelle angegeben, fid_see zeigt
an, ob im See oder auRRerhalb

Intersect: nur die Nistplatze, welche im See liegen, werden

ausgewahlt bzw. in der Attributtabelle gespeichert

43. Daten- und Layoutansicht

->0Offnen

der Map-Ansicht, Erstellen zweier Frames (Ansicht, Ubersicht)

Auswahlen der Frames

—~>Map—>New->0pen

—>Erstellen eines rechteckigen Feldes, um Elemente darin einzufiigen

44. Seiteneinstellungen

—->Wahl des Druckformats (A4), VergroRern der Detailansicht (Fei-Saum) auf

maximale GroRe und Einfiigen der Ubersicht (Niedersachsen), ohne

Bestandteile des anderen Data-Frame zu verdecken.

—>Map->Prepare Page—>A4(Vertical)
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->View RM-> Zoom to Layer Fei-Saum—->Aktivieren Map—>Insert->View

Auswahl des Views

—->Wiederholen mit anderem View

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Aufruf der Layout Ansicht
Hinweise zu Toolbar
Demonstration: Select Elements-Tool

VYV V V

Unterschiedliche Darstellung der Layer

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Unterschied Daten- und Layout- Ansicht

» In Layoutansicht werden alle aktiven Layer abgebildet, unabhangig

vom DF
» Erlauterungen zur Layouttoolbar

45.Legende

—>Einflgen und Positionieren einer Legende

—Insert->Legend

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Insert 2 ,Legend” - Wizard

» Auswahl der Layer, Anzahl der Spalten und Hinweis auf Preview

» Titel, Rahmen, Hintergrundfarbe etc. einstellen

» GrolRRe der Legendenbestandteile (Symbole) festlegen,
,Zeilenabstand” einstellen

A\

- Hervorheben der Anderungen
» rMT Legende: bisherige Einstellungen kénnen geandert werden

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Legende fiir den jeweiligen DF erstellen

46.Nordpfeil

—>Insert=>North Arrow
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Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» Markieren des DF

» Insert 2 , North Arrow”, Auswahl des Symbols

» Doppelklick auf eingefligtes Element 6ffnet ,Properties”, andere
Darstellung, Farbe und Ausrichtung wahlbar

47.Mafdstabszahl, Mafdstabsleiste

—>Einfugen, Definieren und Positionieren von MaRstabselementen

—>lnsert—>Scale

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

> Insert: ,Scale Bar”, MaRstabsleiste auswahlen

» Doppelklick ermoglicht Formatierung der Leiste

» Unterteilungen / Subunterteilungen der Leiste einstellen,
Langeneinheit auswahlen (Division Units)

» Label Position einstellen und Angabe der Stelle auf der
Malstabsleiste, welche die Ldingenangaben angibt

> Insert: ,Scale Text“, automatische Ubernahme der MaRstabszahl fiir
den jeweiligen DF

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise

werden gegeben?):

» Namen der Langeneinheiten sollten mit verwendeter Langeneinheit

Ubereinstimmen

48. Textelemente

Einflgen von Text in eine Karte

—lnsert>Text

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

> Insert ,Text” oder Insert ,Title”

» Titelname automatisch der Name der Karte

» Doppelklick > Properties, anpassende Einstellungen wie z.B. GroRe
des Textfeldes
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49. Ausdehnungsrechtecke

Einfligen eines Ausdehnungsrechtecks in der Ubersichtkarte (Manuelles
EinflUgen von Rechtecken alternativ)

—>lnsert—>Locator.

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

> Hervorheben der Ubersichtskarte und der Detailkarte in der
Layoutansicht

> Auswihlen des DF mit der Ubersichtskarte = , Properties”

» ,Extend Rectangles” ermoglicht Auswahl der DF, fir die eine
Ubersichtskarte erstellt werden sollen

» Auswahlen des DF, Einstellungen (iber ,Frame” anderbar

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise

werden gegeben?):

» Zur Orientierung, wo die detailliert dargestellten Kartenelemente in
der Ubersicht liegen

50. Druck/Export

Angewendete Vorgehensweise (Was wird im Beispielvideo gezeigt?):

» File->“Page and Print Setup”“ = Drucker wahlen

» Einstellungen anpassen, Papierformat, Map Page Size
» Drucken mit File = ,Print”

» Export Gber File =, Export Map“

Formulierung des Sprechtextes (Welche Erganzungen und Hinweise
werden gegeben?):

» Ohne benutzerdefinierte Einstellung wird das Kartenformat an die
eingestellte PapiergroRe angepasst
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